Esri Maps for IBM Cognos
Installation and Configuration Guide

Version 4.3.2
February 5, 2013
Prepared by: Esri
www.esri.com

© Copyright 1995-2012 Esri. All rights reserved.
Use, duplication, or disclosure of this document or any of the information contained herein is subject to the restrictions on the title page of this document.
Contents

1 IBM Cognos Business Intelligence (Review) .................................................................................................................. 1-1
  1.1 Architecture.......................................................................................................................................................... 1-1
    1.1.1 Web tier: The IBM Cognos BI Gateway ........................................................................................................ 1-1
    1.1.2 Application tier: IBM Cognos BI servers ...................................................................................................... 1-1
    1.1.3 Data tier: Content providers .......................................................................................................................... 1-2
    1.1.4 Example IBM Cognos deployment .................................................................................................................. 1-3
  1.2 Distribution options ................................................................................................................................................ 1-3
    1.2.1 All components on one computer ................................................................................................................ 1-4
    1.2.2 Gateways on separate computers ................................................................................................................ 1-4
    1.2.3 Application Tier components and Content Managers on separate computers ........................................ 1-4
  1.3 Communication (BI Bus) ........................................................................................................................................ 1-6

2 Esri Maps for IBM Cognos ........................................................................................................................................... 2-7
  2.1 Architecture.......................................................................................................................................................... 2-7
    2.1.1 Esri Maps Connector: Vantage ...................................................................................................................... 2-7
    2.1.2 Example Esri Maps for IBM Cognos deployment ........................................................................................ 2-8
  2.2 Supported environments ......................................................................................................................................... 2-9
  2.3 System requirements .............................................................................................................................................. 2-9
  2.4 Prerequisites .......................................................................................................................................................... 2-10
  2.5 Default port settings .............................................................................................................................................. 2-10
  2.6 Configuring web browsers .................................................................................................................................... 2-10
  2.7 Installation options ................................................................................................................................................ 2-10
    2.7.1 Windows ......................................................................................................................................................... 2-11
    2.7.2 Linux and UNIX ............................................................................................................................................ 2-12
    2.7.3 Automatic installation .................................................................................................................................. 2-13
  2.8 Configuration ....................................................................................................................................................... 2-13
    2.8.1 Silent configuration ...................................................................................................................................... 2-15
  2.9 IBM Cognos files .................................................................................................................................................... 2-15
    2.9.1 List of files added to IBM Cognos ................................................................................................................ 2-15
    2.9.2 List of modified IBM Cognos files ................................................................................................................ 2-16

3 Installation and configuration: Single computer ................................................................................................. 3-17
  3.1 Installing Esri Maps for IBM Cognos ................................................................................................................... 3-17
  3.2 Configuring using Esri Maps for IBM Cognos Configuration ........................................................................... 3-18
  3.3 Starting the Vantage Server ................................................................................................................................. 3-18
    3.3.1 Windows ......................................................................................................................................................... 3-18
    3.3.2 Linux and UNIX ............................................................................................................................................ 3-18
  3.4 Configuring the web server ................................................................................................................................... 3-19
  3.5 Restarting the IBM Cognos Service ..................................................................................................................... 3-19
  3.6 Performing additional administrative tasks ......................................................................................................... 3-20

4 Installation and configuration: Multiple computers ......................................................................................... 4-21
  4.1 Installation sequence for server components ..................................................................................................... 4-21
  4.2 Vantage Server ..................................................................................................................................................... 4-21
    4.2.1 Installing Vantage Server ............................................................................................................................ 4-21
    4.2.2 Configuring using Esri Maps for IBM Cognos Configuration ...................................................................... 4-22
    4.2.3 Starting the Vantage Server ........................................................................................................................ 4-23
    4.2.4 Performing additional administrative tasks ................................................................................................ 4-23
  4.3 Vantage Server and Vantage Dispatcher .............................................................................................................. 4-24
    4.3.1 Installing Vantage Server and Vantage Dispatcher .................................................................................. 4-24
    4.3.2 Configuring using Esri Maps for IBM Cognos Configuration .................................................................. 4-25
    4.3.3 Starting the Vantage Server ........................................................................................................................ 4-25
    4.3.4 Restarting the IBM Cognos Service ............................................................................................................ 4-26
  4.4 Vantage Dispatcher .............................................................................................................................................. 4-26
    4.4.1 Installing Vantage Dispatcher .................................................................................................................... 4-26
    4.4.2 Configuring using Esri Maps for IBM Cognos Configuration .................................................................. 4-27
## Contents

### 4.4.3 Restarting the IBM Cognos Service ................................................................. 4-28
### 4.5 Vantage Gateway ................................................................................................. 4-28
### 4.5.1 Installing Vantage Gateway .............................................................................. 4-28
### 4.5.2 Configuring using Esri Maps for IBM Cognos Configuration ....................... 4-29
### 4.5.3 Configuring the web server ............................................................................... 4-30
### 4.5.4 Performing additional administrative tasks .................................................... 4-30

### 5 Uninstalling Esri Maps for IBM Cognos .................................................................... 5-31
### 5.1.1 Disabling Esri Maps for IBM Cognos .............................................................. 5-31
### 5.1.2 Stopping/removing the Vantage Server ......................................................... 5-32
### 5.1.3 Removing the web server components ......................................................... 5-32
### 5.1.4 Deleting (or renaming) installed files ......................................................... 5-33

### 6 Upgrading Esri Maps for IBM Cognos ...................................................................... 6-34

### 7 Additional administrative tasks .................................................................................. 7-35
### 7.1 Upgrading reports from previous versions ......................................................... 7-35
### 7.2 Adding map services ......................................................................................... 7-35
### 7.3 Cross-domain security considerations .............................................................. 7-37
### 7.4 Creating a default map .................................................................................... 7-37
### 7.5 Alternate geometry service .............................................................................. 7-37
### 7.6 Configurable options ...................................................................................... 7-38
### 7.7 Configurable Viewer Styles ............................................................................. 7-38
### 7.8 Custom images .............................................................................................. 7-39
### 7.9 Controlling who can access Esri Maps for IBM Cognos .................................... 7-39
### 7.10 Required IBM Cognos Capabilities ............................................................... 7-40
### 7.11 Changing the logging levels ........................................................................... 7-41
### 7.11.1 Vantage Server ....................................................................................... 7-41
### 7.11.2 Vantage Dispatcher ............................................................................... 7-41
### 7.12 IBM Cognos Fix Packs .................................................................................. 7-42

### 8 Appendices ............................................................................................................... 8-43
### 8.1 Configuring the web server .................................................................................. 8-43
### 8.1.1 Microsoft Internet Information Services 6 (IIS 6). ..................................... 8-43
### 8.1.2 Microsoft Internet Information Services 7.x .............................................. 8-46
### 8.1.3 Apache .................................................................................................. 8-50
### 8.2 Testing the configuration .................................................................................. 8-53
### 8.2.1 Vantage Server ....................................................................................... 8-53
### 8.2.2 Vantage Gateway .................................................................................... 8-54
### 8.2.3 Vantage Dispatcher ............................................................................... 8-54

### 8.3 Reports configured with Esri Maps for IBM Cognos ........................................ 8-54
### 8.3.1 Report Variable and Conditional Block ..................................................... 8-54
### 8.3.2 HTML Item ......................................................................................... 8-55
### 8.3.3 Vantage Payload Block ........................................................................... 8-56
List of figures

Figure 1: An example of an IBM Cognos deployment ................................................................. 1-3
Figure 2: All components on one computer .................................................................................... 1-4
Figure 3: Gateways on separate computers .................................................................................... 1-4
Figure 4: More than one Content Manager .................................................................................... 1-5
Figure 5: More than one Application Tier components computer .................................................. 1-6
Figure 6: Esri Maps Connector is powered by Vantage technology ............................................... 2-7
Figure 7: Example Esri Maps for IBM Cognos deployment ........................................................... 2-9
Figure 8: User Account Control message window ......................................................................... 2-12
Figure 9: Esri Maps Designer Launch menu item ........................................................................... 7-40
Figure 10: Esri Maps Designer in Launch menu ............................................................................ 8-54
Figure 11: Vip_mode report string variable .................................................................................... 8-55
Figure 12: Vantage Definition Scripts HTML item ........................................................................ 8-55
Figure 13: HTML items surround target elements ........................................................................... 8-56
Figure 14: Vantage Payload Block ................................................................................................. 8-56
List of tables

Table 1: IBM Cognos installation scripts (Windows) .............................................................. 2-11
Table 2: IBM Cognos installation scripts (UNIX/Linux) .......................................................... 2-12
Table 3: Esri Maps for IBM Cognos Configuration ............................................................... 2-13
Table 4: Local Configuration settings by Vantage component .............................................. 2-15
Table 5: Vantage Server scripts ............................................................................................. 3-19
Table 6: Esri Maps for IBM Cognos virtual directories ......................................................... 3-19
1 IBM Cognos Business Intelligence (Review)

1.1 Architecture

The following is intended to serve as a high-level review of the IBM Cognos Business Intelligence architecture. For a thorough explanation of the concepts discussed here, refer to the IBM Cognos Business Intelligence Architecture and Deployment Guide.

IBM Cognos is a web-based service-oriented architecture (SOA) made up of three server tiers:

- Web tier
- Application tier
- Data tier

Within the IBM Cognos platform, servers are normally grouped together to fulfill certain roles within a distributed deployment. These server roles define the tier within the architecture that an IBM Cognos BI server uses. The tiers are based on business function and are typically separated by network firewalls.

1.1.1 Web tier: The IBM Cognos BI Gateway

The web tier facilitates user connections to IBM Cognos BI applications, and the component that fulfills this role is called the IBM Cognos Gateway. The IBM Cognos Gateway manages all web communication for the IBM Cognos platform. High availability or scalability requirements can be met with multiple redundant gateways being deployed along with an external HTTP load-balancing router.

Web communication in IBM Cognos Business Intelligence is typically through gateways, which reside on one or more web server. A gateway is an extension of a web server program that transfers information from the web server to another server.

Web communication can also occur directly with an IBM Cognos BI dispatcher, although this option is less common than using gateways.

If you install the gateway component on a different computer from Content Manager or Application Tier Components, you must configure the gateway computer so that it knows the location of a dispatcher, preferably one on an Application Tier Components computer. For failover protection, you can configure more than one dispatcher for a gateway computer.

1.1.2 Application tier: IBM Cognos BI servers

The application tier contains one or more IBM Cognos BI servers. An IBM Cognos BI server runs requests, such as reports, analyses, and queries that are forwarded by a gateway. An IBM Cognos BI server also renders the Cognos Connection interface.

The application tier is made up of three main server components:

- IBM Cognos Dispatcher
- IBM Cognos Report Server
- IBM Cognos Content Manager
**IBM Cognos Dispatcher**

The dispatcher starts all IBM Cognos services configured and enabled on a computer and routes requests. The dispatcher can route requests to a local service, such as the report service, presentation service, job service, or monitor service. A dispatcher can also route requests to a specific dispatcher to run a given request. Requests can be routed to specific dispatchers based on load-balancing needs, or package or user group requirements.

When you configure IBM Cognos BI gateways, you can list the universal resource identifiers (URIs) of target dispatchers in order of most to least preferred. If a dispatcher fails, requests are routed to another dispatcher based on the list. When a dispatcher starts, it registers itself with Content Manager. As a result, each dispatcher is aware of the other dispatchers. If a dispatcher fails or is unavailable, requests for that dispatcher are routed to the next available dispatcher until the failed dispatcher reregisters itself.

**IBM Cognos Report Server**

After IBM Cognos BI is installed and configured, one dispatcher is available on each computer by default. Each dispatcher has a set of associated services. IBM Cognos Dispatcher starts IBM Cognos Report Server processes dynamically as needed to handle the request load.

A complete list of the services available is beyond the scope of this document. The following services are noted because they have a direct impact on how Esri Maps for IBM Cognos is installed and configured.

- **Presentation service**
  - Transforms generic XML responses from another service into output format, such as HTML or PDF
  - Provides display, navigation, and administration capabilities in IBM Cognos Connection

- **Report service**
  - Manages interactive requests to run reports and provides output for a user in IBM Cognos Connection or a studio.

**IBM Cognos Content Manager**

IBM Cognos Content Manager is the IBM Cognos Platform service that manages (among other things) the storage of the following application information: security settings and configurations, server configuration settings, packages, report specifications, and report output. IBM Cognos Content Manager maintains information in a relational database referred to as the content store database.

A minimum of one IBM Cognos Content Manager is required for each IBM Cognos Platform implementation.

**1.1.3 Data tier: Content providers**

The IBM Cognos Business Intelligence data tier contains the following:

- **Content Store**: The content store is a relational database that contains data that IBM Cognos BI product needs to operate, such as report specifications, published models, and the packages that contain them; connection information for data sources; information about the external namespace, and the Cognos namespace itself; and information about scheduling and bursting reports.
- **Data Sources**: The data sources that can be accessed through IBM Cognos BI include relational databases, dimensional or OLAP cubes, flat files, and other physical data stores. They also include the connection information necessary for accessing the data.

### 1.1.4 Example IBM Cognos deployment

The following illustrates an example IBM Cognos deployment. There are three dispatchers: one server running the content manager and two servers acting as the report server role.

![IBM Cognos Gateway](image)

**Figure 1: An example of an IBM Cognos deployment**

Use the *IBM Cognos BI Installation and Configuration Guide* for complete information about the IBM Cognos installation and initial configuration process.

For detailed information about IBM Cognos Platform architecture and server deployment options, refer to the *IBM Cognos BI Architecture and Deployment Guide*.

### 1.2 Distribution options

There are many possible configuration options for IBM Cognos BI server components; that is, there are many options for where to place the gateways, the application tier components, and the content manager. Your distribution will follow one of or more of these options:

- All components on one computer
- Gateways on separate computers
- Application Tier Components and Content Manager on separate computers

Before installing and configuring Esri Maps for IBM Cognos, it is important that you understand your IBM Cognos distribution. The following is intended to be a high-level discussion of the distribution options. Please consult the *Business Intelligence Installation and Configuration Guide* for more details.
1.2.1 All components on one computer

This option is typically used for a demonstration or in a proof of concept environment. If you installed all server components for IBM Cognos BI reporting on the same computer, the following are true:

- Your web server is configured to host IBM Cognos web content.
- You have specified the connection information to the content store.

![Diagram of all components on one computer](image)

Figure 2: All components on one computer

1.2.2 Gateways on separate computers

The gateway passes requests from the web server and clients to the dispatcher. It can reside on one or more web servers.

On each computer where the gateway is installed, the following are true:

- The web server is configured to host IBM Cognos web content.
- The Dispatcher URIs are configured.

![Diagram of gateways on separate computers](image)

Figure 3: Gateways on separate computers

1.2.3 Application Tier components and Content Managers on separate computers

Every organization’s processing characteristics are different. Installing the application tier components and/or the content managers on separate computers is intended to address one or more of the following: performance, availability, capacity, or security.
**More than one Content Manager**

An IBM Cognos distribution can have any number of installations of Content Manager. One is active at any time, and the other installations act as a standby. To achieve failover capabilities, Content Manager is often installed on two or more separate computers. Further, the Content Manager can be installed separately from the Application Tier Components. Last, the Content Manager may even exist in the data tier rather than the applications tier.

In the following diagram, a request comes in to the gateway and it passes the request to the dispatcher (not shown). The dispatcher passes it to the default active Content Manager computer. If the computer the active Content Manager is on has failed, the request is redirected to the standby Content Manager computer (which would become the active when the default active Content Manager computer failed).

---

**Figure 4: More than one Content Manager**

On each computer where the content manager is installed, the following are true:

- Connection information to the content store has been specified.
- The Dispatcher URIs have been specified.
- All Content Manager URIs have been specified.
- The Dispatcher URI for external applications has been specified.

**More than one Application Tier components computer**

To improve scalability in an environment in which there is typically a large volume of report requests to process, the Application Tier Components are installed on multiple computers dedicated to processing incoming requests. This distributes and balances loads among the computers and provides better accessibility and throughput than on a single computer, as well as failover support.
On each computer where the Application Tier Components are installed, the following are true:

- All Content Manager URIs have been specified.
- The Dispatcher URIs have been specified.
- The Dispatcher URI for external applications has been specified.
- Only the services that you require on each Application Tier Components computer are enabled.

**Note**: None of the above diagrams represents an actual IBM Cognos implementation. Rather, the diagrams explain the options at the various tiers. An actual implementation would represent more than one of the above, for example, multiple gateways on separate computers, multiple content managers, more than one application tier components computer, and so on. Understanding the IBM Cognos distribution in your environment is very important to note before installing and configuring Esri Maps for IBM Cognos.

### 1.3 Communication (BI Bus)

IBM Cognos Business Intelligence components communicate with each other (and with any additional applications integrated with IBM Cognos BI) using the BI Bus. The BI Bus is not a software component in the traditional sense; rather, it is a set of protocols that govern communications among IBM Cognos services.

Esri Maps for IBM Cognos leverages the capabilities of the BI Bus in order to augment IBM Cognos reports with maps and data.
2 Esri Maps for IBM Cognos

2.1 Architecture

Esri Maps for IBM Cognos is web-based software that integrates maps and data into IBM Cognos Business Intelligence (BI) reports. Three foundational principles have driven the architectural design decisions of this product:

- Parallel the IBM Cognos architecture
- Ready for the enterprise
- Leverage existing systems (that is, no need for additional hardware)

The end result is that Esri Maps for IBM Cognos integrates directly with the IBM Cognos BI architecture. It leverages in-place security, deployment capabilities, scalability, and content promotion.

2.1.1 Esri Maps Connector: Vantage

The Esri Maps Connector is what allows IBM Cognos reports to be augmented by maps. The technology that powers the Esri Maps Connector is known as Vantage. The Vantage technology is responsible for facilitating the communication between IBM Cognos and Esri maps and data.

Figure 6: Esri Maps Connector is powered by Vantage technology

The Vantage technology contains Gateway components, Dispatcher components, and has its own content server.
**Vantage Gateway**

The Vantage Gateway exists in the web tier and gets installed onto all IBM Cognos Gateway servers. In an IBM Cognos deployment, there will be one Vantage Gateway for each IBM Cognos Gateway.

The Vantage Gateway component is used to serve up static files such as images, cascading style sheets (CSS), and JavaScript resources. In addition to these static files, this component also appends items to the IBM Cognos Report Studio toolbox.

**Vantage Dispatcher**

The Vantage Dispatcher component acts as a plug-in to the IBM Cognos Report Service. This is used to bridge the communication between the BI Bus and other Vantage components.

At runtime, the Vantage Dispatcher sends prompt values and context information to the Vantage Server. This ensures both proper security and proper use of any selected user prompts.

The Vantage Dispatcher gets installed onto all IBM Cognos Dispatcher servers that are running the report and/or presentation service. The Vantage Dispatcher does not need to be installed on computers that are exclusively running the content manager.

**Vantage Server**

The Vantage Server is also responsible for handling the synchronization of IBM Cognos report elements at runtime by sending requests to the Cognos Dispatchers and processing the results. It is also responsible for the administration and configuration of Esri Maps for IBM Cognos content (this is done via the Esri Maps Designer interface, which is accessed via IBM Cognos Connection).

The Vantage Server can be installed on any server as long as it meets the minimum requirements for a computer in an IBM Cognos deployment. No IBM Cognos components need to be installed. The Vantage server is a lightweight component, however, and is often installed on one or more computers in the application tier of an IBM Cognos deployment.

If your deployment includes more than one Vantage Server, one is configured as the proxy (or primary) server and is responsible for load balancing between other Vantage Servers. This proxy maintains an affinity cache that directs subsequent requests to the appropriate Vantage Server.

### 2.1.2 Example Esri Maps for IBM Cognos deployment

The following illustrates an example Esri Maps for IBM Cognos deployment:

- Vantage Gateway is installed on the IBM Cognos Gateway server. If there is more than one IBM Cognos Gateway in this example, Vantage Gateway would be installed once per IBM Cognos Gateway.

- Vantage Dispatcher is only installed on the IBM Cognos Dispatcher servers where the report and/or presentation service is running.

- If IBM Cognos Dispatcher is installed more than once on any given server (that is, a dispatcher that listens on a different port number), Vantage Dispatcher would be installed once for every dispatcher that is running the report and/or presentation service.

- Vantage Dispatcher does not get installed onto an IBM Cognos Dispatcher server that is only running Content Manager.
Vantage Server can be installed anywhere in the application tier. There is no requirement that Vantage Server be installed on the same hardware as other IBM Cognos components (although it usually is because it is a lightweight component). There is no requirement that you have the same number of Vantage Servers as Vantage Dispatchers (even though the illustration below shows it this way). Last, the Vantage Server can be installed and configured more than once on any given server (not illustrated).

Figure 7: Example Esri Maps for IBM Cognos deployment

2.2 Supported environments

Esri Maps for IBM Cognos is supported for IBM Cognos 8.4.1 (or greater) on the following operating systems. Refer to the IBM Cognos software environments for your version of IBM Cognos to determine which versions of these operating systems are actively supported:

- Windows Server 2003 (x64 and x86)
- Windows Server 2008 (x64 and x86)
- Red Hat Enterprise Linux (x64, x86, System z*)
- Novell SUSE Linux Enterprise (x64, x86, System z*)
- IBM AIX (x64 and x86)

* Only 64-bit versions of System z are supported.

Esri Maps for IBM Cognos is supported for use with IBM Cognos Enterprise. It is not supported for use with IBM Cognos Express or any developer edition.

Esri Maps for IBM Cognos assumes on-site or online access to map services published via ArcGIS Server 9.3 or greater.

2.3 System requirements

Esri Maps for IBM Cognos will run on any computer that meets the minimum requirements for IBM Cognos. Refer to the Business Intelligence Installation and Configuration Guide for your version of IBM Cognos more information.

A full installation of Esri Maps for IBM Cognos requires 1 GB of free disk space.
2.4 Prerequisites

The following prerequisites exist for running the Esri Maps for IBM Cognos Vantage Gateway on Linux and UNIX operating systems.

**Linux**
- linux-gate.so.1 (substitute with linux-vdso.so.1 on 64bit Linux)
- libc.so.6
- librt.so.1
- libdl.so.2
- ld-linux.so.2
- libpthread.so.0

**AIX**
- libc.a

**System z**
- ld64.so.1

2.5 Default port settings

The following ports are the default ports used by Esri Maps for IBM Cognos. They can be changed in Esri Maps for IBM Cognos Configuration.

- 9796: Vantage Server HTTP Port
- 9795: Vantage Server Shutdown Port

2.6 Configuring web browsers

Esri Maps for IBM Cognos will work in any actively supported browser for your version of IBM Cognos.

Note, however, that Esri Maps for IBM Cognos has the additional requirement of Adobe Flash Player 11.2 or above. For detailed system requirements for Flash Player read the most up-to-date information by Adobe.

After upgrading or installing Esri Maps for IBM Cognos software, advise your users to restart their web browser and clear their browser cache (this can be accomplished in most browsers using CTRL-SHIFT-DELETE).

2.7 Installation options

You typically run the Esri Maps for IBM Cognos installation and configuration programs interactively with a graphical user interface which allows you to provide the required information. In an interactive installation, you use the installation wizard to select the server components that you want to install and the location on your computer where you want to install them. You use the configuration application to configure the various Esri Maps for IBM Cognos components.

On Windows-based platforms, interactive installations and configurations are performed using the operating system’s built-in windowing capabilities. On other platforms, interactive
installations and configurations are typically performed from an X Window System (X11) workstation, an X terminal, or a PC with X server software installed.

Regardless of the operating system being used, an interactive-mode installation or configuration must be run on a console that supports Java-based graphical user interfaces.

You can automate the installation of components using installation scripts and configuration files. In this scenario, you run the installation and configuration programs in silent mode.

As long as the installed components are the same, you can automate the configuration of components by exporting/copying the installation and configuration settings from one computer to another. In this scenario, the Esri Maps for IBM Cognos installation and Esri Maps for IBM Cognos Configuration are run in interactive mode on the first computer. On subsequent computers, you run the installation and configuration in silent/unattended mode.

2.7.1 Windows

For Microsoft Windows operating system installations, ensure that a TEMP system variable is set and that it points to a directory where you can store temporary files (files from the disk are temporarily copied to this directory during installation).

The Esri Maps for IBM Cognos media is delivered to you either via an ISO Image file (.iso) or backup DVD. Before installing with an ISO image file, you should

1. Use an ISO Image mounting program to use the ISO image file as a virtual disk (for example, Virtual CloneDrive).

2. Use an ISO Image extractor program to extract the files within an ISO image file to disk (for example, 7-Zip, IsoBuster).

Use the following table to identify the correct installation script for your version of IBM Cognos.

<table>
<thead>
<tr>
<th>IBM Cognos version</th>
<th>Installation script</th>
</tr>
</thead>
<tbody>
<tr>
<td>8.4.1</td>
<td>launchInstaller841.bat</td>
</tr>
<tr>
<td>10.1</td>
<td>launchInstallerC10.bat</td>
</tr>
<tr>
<td>10.1.1</td>
<td>launchInstallerC10_1_1.bat</td>
</tr>
<tr>
<td>10.2</td>
<td>launchInstallerC10_2.bat</td>
</tr>
</tbody>
</table>

Table 1: IBM Cognos installation scripts (Windows)

User Account Control

User Account Control (UAC) is a technology and security infrastructure introduced with Microsoft Windows Vista and Windows Server 2008 operating systems. It is intended to improve the security of Microsoft Windows by limiting application software to standard user privileges until an administrator authorizes an increase or elevation.

Esri Maps for IBM Cognos Configuration does request an elevation of privileges during the installation and configuration process. In an environment with UAC turned on, you must confirm the elevation request in order to proceed. Esri Maps for IBM Cognos Configuration (internally) leverages a Java Runtime Environment and that is why the User Access Control message box lists java.exe as the program name.
If UAC is turned off in your environment, you should still perform all Esri Maps for IBM Cognos installation and configuration tasks as a user with administrator privileges.

### 2.7.2 Linux and UNIX

For Linux- and UNIX-based operating system installations, install server components using a graphic user interface or by running an unattended installation. To install with a graphical user interface, the console attached to your computer must support a Java-based graphic user interface. To run an unattended installation, you must first run a graphical-mode installation on a separate computer and save the installation script when prompted.

For Linux- and UNIX-based operating systems, the *IBM Cognos Installation and Configuration Guide* recommends the creation of a group named ibmcognos (or similar). This group must contain the user who owns the IBM Cognos files (that is, the user who installed IBM Cognos). After installation, the ibmcognos group takes ownership of the IBM Cognos files, and the file permissions for all IBM Cognos files are changed to GROUP READ/WRITE/EXECUTE.

For ease of administration and configuration, it is recommended that Esri Maps for IBM Cognos be installed by the user who owns the IBM Cognos installation location. Further, after Esri Maps for IBM Cognos is installed, the ibmcognos group should take ownership of the Esri Maps for IBM Cognos files, and the file permissions for all Esri Maps for IBM Cognos files should be set to GROUP READ/WRITE/EXECUTE.

For instructions on mounting the ISO image file, see the administration documentation for your operating system. After you mount the image, you may need to copy its contents to a location where you can assign the user who will own the Esri Maps for IBM Cognos installation location READ/WRITE/EXECUTE permissions.

Use the following table to identify the correct installer script for your version/platform of IBM Cognos.

<table>
<thead>
<tr>
<th>IBM Cognos</th>
<th>Linux</th>
<th>AIX</th>
<th>System z</th>
</tr>
</thead>
<tbody>
<tr>
<td>8.4.1</td>
<td>launchInstaller841.sh</td>
<td>launchInstaller841-aix.sh</td>
<td>launchInstaller841-systemz.sh</td>
</tr>
<tr>
<td>10.1</td>
<td>launchInstallerC10.sh</td>
<td>launchInstallerC10-aix.sh</td>
<td>launchInstallerC10-systemz.sh</td>
</tr>
<tr>
<td>10.1.1</td>
<td>launchInstallerC10_1_1.sh</td>
<td>launchInstallerC10_1_1-aix.sh</td>
<td>launchInstallerC10_1_1-systemz.sh</td>
</tr>
<tr>
<td>10.2</td>
<td>launchInstallerC10_2.sh</td>
<td>launchInstallerC10_2-aix.sh</td>
<td>launchInstallerC10_2-systemz.sh</td>
</tr>
</tbody>
</table>

**Table 2: IBM Cognos installation scripts (UNIX/Linux)**
2.7.3 Automatic installation

If the information provided to the Esri Maps for IBM Cognos installer was saved during a previous installation, it can be used to perform an automatic/unattended installation on a similar computer.

Windows

The following example assumes a file named install.xml was saved to the root of the C:\ drive and that the Esri Maps for IBM Cognos installation media is located at D:\em4c. The following should be executed in a command prompt (cmd.exe) that is being run as administrator.

D:\em4c\java\jre\bin\java.exe -jar D:\em4c\Vantage\vantage-installer-C10_2.jar C:\install.xml

Linux and UNIX

The following example assumes a file named install.xml was saved to the /tmp folder and that the Esri Maps for IBM Cognos installation media is located at /tmp/em4c. The following should be executed as the user who owns the IBM Cognos installation on the target computer.

/tmp/em4c/java/jre-linux/bin/java -jar /tmp/em4c/Vantage/vantage-installer-C10_2.jar /tmp/install.xml

Note: Modify the java path and the named vantage-installer file to reflect your IBM Cognos platform/version.

2.8 Configuration

Esri Maps for IBM Cognos Configuration is installed with Esri Maps for IBM Cognos. You use it immediately after installation to set the initial configuration or at any point in the future to make updates. Esri Maps for IBM Cognos Configuration is used on every computer on which Esri Maps for IBM Cognos is installed.

<table>
<thead>
<tr>
<th>Item</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM Cognos Gateway (Basic URL)</td>
<td><a href="http://localhost:8080/cartogiscognos">http://localhost:8080/cartogiscognos</a></td>
</tr>
<tr>
<td>IBM Cognos Desktop (Basic URL)</td>
<td><a href="http://localhost:9001">http://localhost:9001</a></td>
</tr>
<tr>
<td>Vantage Gateway (Advanced)</td>
<td></td>
</tr>
<tr>
<td>Vantage Server Name (Advanced)</td>
<td></td>
</tr>
<tr>
<td>Vantage Server Shutdown Port (Advanced)</td>
<td></td>
</tr>
<tr>
<td>Vantage Server HTTP Port (Advanced)</td>
<td></td>
</tr>
<tr>
<td>Esri Maps for IBM Cognos Service Name (Advanced)</td>
<td></td>
</tr>
<tr>
<td>Esri Maps for IBM Cognos Service Log File</td>
<td>c:\esricarto\cognos\server\system\cognos\service\log</td>
</tr>
</tbody>
</table>
When you run Esri Maps for IBM Cognos Configuration in interactive mode, there are three buttons on the user interface.

- **Apply**
  - Saves the Local Configuration settings to vantage.xml
  - Makes necessary updates to IBM Cognos files
  - Starts the Esri Maps for IBM Cognos service (Windows only)

- **Revert**
  - Returns the Esri Maps for IBM Cognos to the last saved (that is, applied) settings

- **Disable**
  - Removes changes made to IBM Cognos files
  - Stops and removes the Esri Maps for IBM Cognos service (Windows only)

The Local Configuration settings specified on Esri Maps for IBM Cognos Configuration are used by the various Esri Maps for IBM Cognos components and can be modified at any time. The settings available are as follows:

- **IBM Cognos Gateway Base URI**: The IBM Cognos gateway URI without /cgi-bin/cognos.cgi. This is used internally by Esri Maps for IBM Cognos.

- **IBM Cognos Dispatcher(s)**: A comma-separated list of all Cognos dispatchers in your environment. Esri Maps for IBM Cognos uses a failover algorithm to decide which dispatcher a Vantage Server will contact. The Vantage Server makes requests to the first dispatcher unless it has become disabled then proceeds to the next one in the list, and so on. For example, http://server1:9300, http://server1:9301, and http://server2:9300. (Note: There should be no spaces between server names when specified on Esri Maps for IBM Cognos Configuration. They are included here for readability). The order of this list is not crucial, and it is recommended that you list the IBM Cognos dispatchers on the local computer, followed by IBM Cognos Dispatchers on other computers.

- **Vantage Server URI(s)**: An ordered, comma-separated list of Esri Maps for IBM Cognos Servers in the environment. Note: This list must appear in the same order in all Esri Maps for IBM Cognos Configuration instances in your environment. The list denotes the order in which Vantage Servers take the role of primary. If the first server fails, all components must agree that the second server in the list will act as primary until the first server is back online. For example, http://server1:9796/vantage, http://server1:9896/vantage, and http://server2:9796/vantage. (Note: There should be no spaces between server names when specified on Esri Maps for IBM Cognos Configuration. They are included here for readability).

- **Vantage Server Shutdown Port (Advanced)**: The shutdown port for the local Vantage Server. This should be left alone unless you have multiple Vantage Servers installed on the same computer or there will be a port conflict.

- **Vantage Server HTTP Port (Advanced)**: The HTTP port on which the local Vantage Server will listen. This should be left alone unless you have multiple Vantage Servers installed on the same computer or there will be a port conflict. If you edit this value, be sure to update **Vantage Server URI(s)** accordingly.

- **Vantage Server Log File**: The location of the log files that will be generated by the Vantage Server.

The local configuration settings required for each Vantage component are as follows:
Local Configuration Setting | Vantage Server | Vantage Gateway | Vantage Dispatcher
--- | --- | --- | ---
IBM Cognos Gateway Base URI | ✓ | | |
IBM Cognos Dispatcher(s) | ✓ | | |
Vantage Server URI(s) | ✓ | ✓ | ✓
Vantage Server Shutdown Port (Advanced) | | ✓ | ✓
Vantage Server HTTP Port (Advanced) | ✓ | | |
Vantage Server Log File | ✓ | | |

Table 4: Local Configuration settings by Vantage component

2.8.1 Silent configuration

Esri Maps for IBM Cognos Configuration saves its local settings to a file named vantage.xml. This XML file can be used to distribute Esri Maps for IBM Cognos to multiple computers (as long as they have the same settings and paths). To perform a silent configuration, a successful configuration on another computer with the exact same setup must first be completed.

**Windows**

The following should be completed as an administrator:

1. Copy vantage.xml from the em4c_location/configure directory on the source computer to the em4c_location/configure directory on the target computer.
2. On the target computer, navigate to the em4c_configure directory.
3. Run the following command:
   ```sh
configure.bat -silent
   ```

**Linux and UNIX**

The following should be completed as the user who owns the Esri Maps for IBM Cognos installation location.

1. Copy vantage.xml from the em4c_location/configure directory on the source computer to the em4c_location/configure directory on the target computer.
2. On the target computer, navigate to the em4c_configure directory.
3. Depending on the environment, run one of the following:
   ```sh
   ./configure.sh -silent (Linux)
   ./configure-aix.sh -silent (AIX)
   ./configure-systemz.sh -silent (System z)
   ```

2.9 IBM Cognos files

2.9.1 List of files added to IBM Cognos

During the Esri Maps for IBM Cognos installation process, some directories and files are copied to the IBM Cognos installation location (cognos_location). They are as follows:
**IBM Cognos Gateway computers**

cognos_location /webcontent/rv/vip (and all its children)
cognos_location /webcontent/pat/res/vantage (and all its children)

**IBM Cognos Dispatcher computers**

cognos_location /webapps/p2pd/WEB-INF/classes/spotonvantage.properties
cognos_location /webapps/p2pd/WEB-INF/lib/vantageRSVPHandler.jar
cognos_location /templates/ps/portal/vip_save_default_prompts.xts
cognos_location /templates/ps/logicsheets/presentation/dialog/vip_save_prompts.ui-templates.xsl

**2.9.2 List of modified IBM Cognos files**

During the configuration process, some IBM Cognos files are modified. Modified files are backed up by Esri Maps for IBM Cognos. See cmplst_vantage.txt for a complete list of modified files, and their original location.

**Note:** The following IBM Cognos files are not modified during the installation process (when Esri Maps for IBM Cognos files are copied into the environment). They are only modified during the configuration process.

**IBM Cognos Gateway computers**

cognos_gateway_location/webcontent/pat/res/reportstudio_LOCALE.xml
cognos_gateway_location/webcontent/pat/res/toolbox.xml
cognos_gateway_location/webcontent/pat/res/toolboxControls.xml

**IBM Cognos Dispatcher computers**

cognos dispatcher cognos_location/webapps/p2pd/web-inf/services/reportService.xml
cognos dispatcher location/templates/ps/portal/system.xml
3 Installation and configuration: Single computer

Installing and configuring Esri Maps for IBM Cognos on a single computer involves the following steps:

Step 1. Install Esri Maps for IBM Cognos.
Step 2. Configure using Esri Maps for IBM Cognos Configuration.
Step 3. Start the Vantage Server.
Step 4. Configure the web server.
Step 5. Restart the IBM Cognos Service.
Step 6. Perform additional administrative tasks.

3.1 Installing Esri Maps for IBM Cognos

A complete installation of Esri Maps for IBM Cognos involves installing components on your server then configuring them to work in your environment. Before you begin, make sure you are familiar with the installation options.

On Windows, the following steps should be performed as an administrator. On Linux and UNIX, it is recommended that the following steps be performed as the user who owns the IBM Cognos installation location.

On Linux and UNIX platforms, install Esri Maps for IBM Cognos components in a directory that contains only ASCII characters in the path.

1. Do one of the following:
   - In the Vantage directory on the installation media, launch the correct installer batch file (.bat) for your version of IBM Cognos. For example:
     G:\Vantage>launchInstallerC10_2.bat
   - In terminal, navigate to the Vantage directory on the installation media and launch the installer that reflects your version and platform of IBM Cognos. For example:
     [cognosuser@server1]$ ./launchInstallerC10_2.sh

2. On the Welcome page, click Next.
3. If you accept the terms of the license agreement, click Next; otherwise, click Quit to exit.
4. Select the installation path and click Next.
5. Ensure Vantage Gateway, Vantage Dispatcher, and Vantage Server are selected and click Next.
6. Specify the IBM Cognos Gateway Directory and click Next.
7. Specify the IBM Cognos Dispatcher Directory and click Next.
8. Wait for files to be copied to the specified location and click Next.
9. Optionally, click Generate an automatic installation script in order to save an XML file containing all the parameters you set on the previous pages.
10. Click Done.
11. After installing on Linux and UNIX platforms, navigate to \em4c_location\configure and enter the following:
   [cognosuser@server1]$ chmod +x setPermissions.sh
   [cognosuser@server1]$ ./setPermissions.sh

3.2 Configuring using Esri Maps for IBM Cognos Configuration

Before you complete the following steps, make sure you are familiar with the available configuration settings.

On Windows, run Esri Maps for IBM Cognos Configuration as a user with administrator privileges. On Linux and UNIX, run Esri Maps for IBM Cognos Configuration as the user who owns the Esri Maps for IBM Cognos installation location (this user should have READ/WRITE/EXECUTE access to both the \em4c_location and the \cognos_location).

1. Do one of the following:
   - On Windows, navigate to the \em4c_location\configure directory and launch configure.bat.
   - On Linux or UNIX, navigate to the \em4c_location\configure directory and run one of the following:
     ./configure.sh (Linux)
     ./configure-aix.sh (AIX)
     ./configure-systemz.sh (System z)

2. In the Explorer window, click Local Configuration.

3. Change the Local Configuration settings to reflect your environment (for example, the host name portion of any URI should be changed from localhost to an IP address or a network host name). The Esri Maps for IBM Cognos Configuration application recognizes which Vantage components are installed and only lists the configuration settings that are required to be set.

4. Click the Apply button.

5. From the File menu, click Exit.

3.3 Starting the Vantage Server

The Esri Maps for IBM Cognos Vantage Server needs to be started for all locations where the Vantage Server component was installed.

3.3.1 Windows

On Microsoft Windows operating systems, Vantage Server runs as a service and is configured to start automatically by default (it can be restarted manually using Microsoft Management Console).

3.3.2 Linux and UNIX

On Linux and UNIX operating systems, the Vantage Server process is started and stopped with the use of shell scripts. These scripts are located at \em4c_location\server\bin and should be run as the user who owns the Esri Maps for IBM Cognos installation location.
Installation and configuration: Single computer

### Platform Scripts

<table>
<thead>
<tr>
<th>Platform</th>
<th>Start</th>
<th>Stop</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linux</td>
<td>start-vantage.sh</td>
<td>stop-vantage.sh</td>
</tr>
<tr>
<td>AIX</td>
<td>start-vantage-aix.sh</td>
<td>stop-vantage-aix.sh</td>
</tr>
<tr>
<td>System z</td>
<td>start-vantage-systemz.sh</td>
<td>stop-vantage-systemz.sh</td>
</tr>
</tbody>
</table>

**Table 5: Vantage Server scripts**

For example:

```bash
[cognosuser@server1]$ cd /opt/em4c/server/bin
[cognosuser@server1]$ ./start-vantage.sh
```

or

```bash
[cognosuser@server1]$ /opt/em4c/server/bin/start-vantage.sh
```

To automatically start the Esri Maps for IBM Cognos process on UNIX and Linux operating systems, you must configure the process as a daemon. For more information, see your operating system documentation.

### 3.4 Configuring the web server

In order for Esri Maps for IBM Cognos and IBM Cognos to communicate, you must create the virtual directories (aliases) listed in the following table. Note that it is assumed IBM Cognos is exposed on your web server as ibmcognos (modify to reflect your environment).

<table>
<thead>
<tr>
<th>Alias</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>ibmcognos/esriViewer</td>
<td>em4c_location/gateway/webcontent/esriViewer</td>
</tr>
<tr>
<td>ibmcognos/vantage</td>
<td>em4c_location/gateway/webcontent/vantage</td>
</tr>
<tr>
<td>ibmcognos/vantage/cgi-bin</td>
<td>cgi-bin directory that reflects your environment, for example em4c_location/gateway/cgi/linux-64/cgi-bin</td>
</tr>
</tbody>
</table>

**Table 6: Esri Maps for IBM Cognos virtual directories**

Detailed configuration steps for the following web servers are included as an appendix to this document.

- Microsoft Internet Information Services 6 (IIS6)
- Microsoft Internet Information Services 7.x (IIS7)
- Apache

### 3.5 Restarting the IBM Cognos Service

Changes applied in Esri Maps for IBM Cognos Configuration require that the IBM Cognos Service be restarted on any IBM Cognos Dispatcher computer that is running the report service and/or presentation service.

Refer to the *IBM Cognos Installation and Configuration Guide* for your version of IBM Cognos for details on how to restart the IBM Cognos service.

At this point, all Esri Maps for IBM Cognos report authors and end users should clear their web browser cache. The instructions for this vary among browsers, but CTRL-SHIFT-DELETE will work in most browsers.
3.6 Performing additional administrative tasks

Before report authors can start using Esri Maps for IBM Cognos to enhance reports with maps, there are some additional administrative tasks that must be performed. Not all additional tasks will be applicable to your environment.
4 **Installation and configuration: Multiple computers**

A complete installation of Esri Maps for IBM Cognos involves installing components on your server and configuring them to work in your environment. Before you begin, make sure you are familiar with the installation options.

If you plan to install two or more different Esri Maps for IBM Cognos components on the same computer (for example, Vantage Dispatcher and Vantage Server), install them in the same installation location to avoid potential conflicts and to ensure ease of configuration. If you plan to install the same Esri Maps for IBM Cognos component more than once on the same computer (for example, two Vantage Servers for failover), you must install them in different locations in order to avoid files from being overwritten.

**4.1 Installation sequence for server components**

The order in which the Esri Maps for IBM components are set up does not matter as everything has been completed so the software will operate. For ease of configuration, however, the following order is recommended:

1. Vantage Servers
2. Vantage Dispatchers
3. Vantage Gateways

**Note:** In many environments, the Vantage Server and Vantage Dispatchers get installed on the same computer. As such, these components get installed and configured at the same time. This situation is addressed in the Vantage Server and Vantage Dispatcher section below.

**4.2 Vantage Server**

Depending on your environment, the Vantage Server component can be installed on one or more computers. Also, the Vantage Server component can be installed on the same computer more than once (in separate target paths).

Installing and configuring Vantage Server on one computer involves the following steps:

Step 1. Install Vantage Server.
Step 2. Configure using Esri Maps for IBM Cognos Configuration.
Step 3. Start the Vantage Server (Linux and UNIX).
Step 4. Perform additional administrative tasks.

This section describes the scenario where only Vantage Server is being installed (Vantage Dispatcher will be installed on a different computer). When Vantage Server and Vantage Dispatcher are installed on the same computer, refer to the Vantage Dispatcher and Vantage Server instructions.

**4.2.1 Installing Vantage Server**

A complete installation of Esri Maps for IBM Cognos involves installing components on your server then configuring them to work in your environment. Before you begin, make sure you are familiar with the installation options.
On Windows, the following steps should be performed as an administrator. On Linux and UNIX, it is recommended that the following steps be performed as the user who owns the IBM Cognos installation location.

On Linux and UNIX platforms, install Esri Maps for IBM Cognos components in a directory that contains only ASCII characters in the path.

1. Do one of the following:
   - On Windows, in the Vantage directory on the installation media, launch the correct installer batch file (.bat) for your version of IBM Cognos. For example:
     
     \G:\Vantage\launchInstallerC10_2.bat
   - On Linux and UNIX, in terminal, navigate to the Vantage directory on the installation media and launch the installer that reflects your version/platform of IBM Cognos. For example:
     
     \[cognosuser@server1\]$ ./launchInstallerC10_2.sh

2. On the Welcome page, click Next.

3. If you accept the terms of the license agreement, click Next; otherwise, click Quit to exit.

4. Select the installation path and click Next.

5. Ensure that only the Vantage Server component is selected and click Next.

6. Wait for files to be copied to the specified location and click Next.

7. Optionally, click Generate an automatic installation script in order to save an XML file containing all the parameters you set on the previous pages.

8. Click Done.

9. After installing on Linux and UNIX platforms, navigate to em4c_location/configure and enter the following:

   \[cognosuser@server1\]$ chmod +x setPermissions.sh
   \[cognosuser@server1\]$ ./setPermissions.sh

### 4.2.2 Configuring using Esri Maps for IBM Cognos Configuration

Before you complete the following steps, make sure you are familiar with the available configuration settings.

On Windows, run Esri Maps for IBM Cognos Configuration as a user with administrator privileges. On Linux and UNIX, run Esri Maps for IBM Cognos Configuration as the user who owns the Esri Maps for IBM Cognos installation location (this user should have READ/WRITE/EXECUTE access to both the em4c_location and the cognos_location).

1. Do one of the following:
   - On Windows, navigate to the em4c_location|configure directory and launch configure.bat.
   - On Linux or UNIX, navigate to the em4c_location/configure directory and run one of the following:
     
     ./configure.sh  (Linux)
     ./configure-aix.sh  (AIX)
     ./configure-systemz.sh  (System z)

2. In the Explorer window, click Local Configuration.
3. Change the Local Configuration settings to reflect your environment (for example, the host name portion of any URI should be changed from localhost to an IP address or a network host name). The Esri Maps for IBM Cognos Configuration application recognizes which Vantage components are installed and only lists the configuration settings that are required to be set.

4. Click the **Apply** button.

5. From the **File** menu, click **Exit**.

**Note:** For Windows installations where Vantage Server is installed more than once on a given computer, it is important in step 3 above to make sure that the Esri Maps for IBM Cognos Service Name is different for each instance of Vantage Server.

### 4.2.3 Starting the Vantage Server

The Esri Maps for IBM Cognos Vantage Server needs to be started for all locations where the Vantage Server component was installed.

**Windows**

On Microsoft Windows operating systems, Vantage Server runs as a service and is configured to start automatically by default (it can be restarted manually using Microsoft Management Console).

**Linux and UNIX**

On Linux and UNIX operating systems, the Vantage Server process is started and stopped with the use of shell scripts. These scripts are located at `em4c_location/server/bin` and should be run as the user who owns the Esri Maps for IBM Cognos installation location.

<table>
<thead>
<tr>
<th>Platform</th>
<th>Start</th>
<th>Stop</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linux</td>
<td><code>start-vantage.sh</code></td>
<td><code>stop-vantage.sh</code></td>
</tr>
<tr>
<td>AIX</td>
<td><code>start-vantage-aix.sh</code></td>
<td><code>stop-vantage-aix.sh</code></td>
</tr>
<tr>
<td>System z</td>
<td><code>start-vantage-systemz.sh</code></td>
<td><code>stop-vantage-systemz.sh</code></td>
</tr>
</tbody>
</table>

**Table 5: Vantage Server scripts**

For example:

```
[cognosuser@server1]$ cd /opt/em4c/server/bin
[cognosuser@server1]$ ./start-vantage.sh
```

or

```
[cognosuser@server1]$ /opt/em4c/server/bin/start-vantage.sh
```

To automatically start the Esri Maps for IBM Cognos process on UNIX and Linux operating systems, you must configure the process as a daemon. For more information, see your operating system documentation.

### 4.2.4 Performing additional administrative tasks

Before report authors can start using Esri Maps for IBM Cognos to enhance reports with maps, there are some additional administrative tasks that must be performed. Not all additional tasks will be applicable to your environment.
4.3 Vantage Server and Vantage Dispatcher

Because of the small processing requirements of the Vantage Server, many organizations choose to install it along with the Vantage Dispatcher (note that the Vantage Dispatcher gets installed on each IBM Cognos Dispatcher computer that is running the report service and/or presentation service). Installing and configuring the Vantage Server and Vantage Dispatcher together involves the following steps:

Step 1. Install Vantage Dispatcher and Vantage Server.
Step 2. Configure using Esri Maps for IBM Cognos Configuration.
Step 3. Start the Vantage Server (Linux and UNIX).
Step 4. Restart the IBM Cognos Service.

4.3.1 Installing Vantage Server and Vantage Dispatcher

A complete installation of Esri Maps for IBM Cognos involves installing components on your server then configuring them to work in your environment. Before you begin, make sure you are familiar with the installation options.

On Windows, the following steps should be performed as an administrator. On Linux and UNIX, it is recommended that the following steps be performed as the user who owns the IBM Cognos installation location.

On Linux and UNIX platforms, install Esri Maps for IBM Cognos components in a directory that contains only ASCII characters in the path.

1. Do one of the following:
   - On Windows, in the Vantage directory on the installation media, launch the correct installer batch file (.bat) for your version of IBM Cognos. For example:
     \G:\Vantage>launchInstallerC10_2.bat
   - On Linux or UNIX, in terminal, navigate to the Vantage directory on the installation media, and launch the installer that reflects your version/platform of IBM Cognos. For example
     \[cognosuser@server1]\$ ./launchInstallerC10_2.sh

2. On the Welcome page, click Next.
3. If you accept the terms of the license agreement, click Next. Otherwise click Quit to exit.
4. Select the installation path and click Next.
5. Ensure that Vantage Server and Vantage Dispatcher components (only) are selected and click Next.
6. Specify the IBM Cognos Dispatcher directory and click Next.
7. Wait for files to be copied to the specified location, and click Next.
8. Optionally, click Generate an automatic installation script in order to save an XML file containing all the parameters you set on the previous pages.
9. Click Done.
10. After installing on Linux and UNIX platforms, navigate to $em4c_location$/configure and enter the following:

[cognosuser@server1]$ chmod +x setPermissions.sh
[cognosuser@server1]$ ./setPermissions.sh

4.3.2 Configuring using Esri Maps for IBM Cognos Configuration

Before you complete the following steps, make sure you are familiar with the available configuration settings.

On Windows, run Esri Maps for IBM Cognos Configuration as a user with administrator privileges. On Linux and UNIX, run Esri Maps for IBM Cognos Configuration as the user who owns the Esri Maps for IBM Cognos installation location (this user should have READ/WRITE/EXECUTE access to both the $em4c_location$ and the $cognos_location$).

1. Do one of the following:
   - On Windows, navigate to the $em4c_location$/configure directory and launch configure.bat.
   - On Linux or UNIX, navigate to the $em4c_location$/configure directory and run one of the following:
     ```
     ./configure.sh  \(\text{Linux}\)
     ./configure-aix.sh \(\text{AIX}\)
     ./configure-systemz.sh \(\text{System z}\)
     ```

2. In the Explorer window, click Local Configuration.

3. Change the Local Configuration settings to reflect your environment (for example, the host name portion of any URI should be changed from localhost to an IP address or a network host name). The Esri Maps for IBM Cognos Configuration application recognizes which Vantage components are installed and only lists the configuration settings that are required to be set.

4. Click the Apply button.

5. From the File menu, click Exit.

   **Note:** For Windows installations where Vantage Server is installed more than once on a given computer, it is important in step 3 above to make sure that the Esri Maps for IBM Cognos Service Name is different for each instance of Vantage Server.

4.3.3 Starting the Vantage Server

The Esri Maps for IBM Cognos Vantage Server needs to be started for all locations where the Vantage Server component was installed.

**Windows**

On Microsoft Windows operating systems, Vantage Server runs as a service and is configured to start automatically by default (it can be restarted manually using Microsoft Management Console).

**Linux and UNIX**

On Linux and UNIX operating systems, the Vantage Server process is started and stopped with the use of shell scripts. These scripts are located at $em4c_location$/server/bin and should be run as the user who owns the Esri Maps for IBM Cognos installation location.
### Platform

<table>
<thead>
<tr>
<th>Platform</th>
<th>Start</th>
<th>Stop</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linux</td>
<td>start-vantage.sh</td>
<td>stop-vantage.sh</td>
</tr>
<tr>
<td>AIX</td>
<td>start-vantage-aix.sh</td>
<td>stop-vantage-aix.sh</td>
</tr>
<tr>
<td>System z</td>
<td>start-vantage-systemz.sh</td>
<td>stop-vantage-systemz.sh</td>
</tr>
</tbody>
</table>

**Table 5: Vantage Server scripts**

For example:

```
[cognosuser@server1]$ cd /opt/em4c/server/bin
[cognosuser@server1]$ ./start-vantage.sh
```

or

```
[cognosuser@server1]$ /opt/em4c/server/bin/start-vantage.sh
```

To automatically start the Esri Maps for IBM Cognos process on UNIX and Linux operating systems, you must configure the process as a daemon. For more information, see your operating system documentation.

#### 4.3.4 Restarting the IBM Cognos Service

Changes applied in Esri Maps for IBM Cognos Configuration require that the IBM Cognos Service be restarted on any IBM Cognos Dispatcher computer that is running the report service and/or presentation service.

Refer to the *IBM Cognos Installation and Configuration Guide* for your version of IBM Cognos for details on how to restart the IBM Cognos service.

At this point, all Esri Maps for IBM Cognos report authors and end users should clear their web browser cache. The instructions for this vary among browsers, but CTRL-SHIFT-DELETE will work in most browsers.

### 4.4 Vantage Dispatcher

The Vantage Dispatcher must be installed on each IBM Cognos Dispatcher computer running the report service and/or presentation service. Installing and configuring the Vantage Dispatcher involves the following steps:

1. **Step 1. Install Vantage Dispatcher.**
2. **Step 2. Configure using Esri Maps for IBM Cognos Configuration.**
3. **Step 3. Restart the IBM Cognos Service.**

This section describes the situation where only Vantage Dispatcher is being installed (Vantage Server will be installed on a separate computer). When Vantage Dispatcher and Vantage Server are installed on the same computer, refer to the Vantage Dispatcher and Vantage Server instructions.

#### 4.4.1 Installing Vantage Dispatcher

A complete installation of Esri Maps for IBM Cognos involves installing components on your server then configuring them to work in your environment. Before you begin, make sure you are familiar with the installation options.
On Windows, the following steps should be performed as an administrator. On Linux and UNIX, it is recommended that the following steps be performed as the user who owns the IBM Cognos installation location.

On Linux and UNIX platforms, install Esri Maps for IBM Cognos components in a directory that contains only ASCII characters in the path.

1. Do one of the following:
   - On Windows, in the Vantage directory on the installation media, launch the correct installer batch file (.bat) for your version of IBM Cognos. For example:
     ```
     G:\Vantage>launchInstallerC10_2.bat
     ```
   - On Linux or UNIX, in terminal, navigate to the Vantage directory on the installation media, and launch the installer that reflects your version/platform of IBM Cognos. For example:
     ```
     [cognosuser@server1]$ ./launchInstallerC10_2.sh
     ```

2. On the **Welcome** page, click **Next**.

3. If you accept the terms of the license agreement, click **Next**; otherwise, click **Quit** to exit.

4. Select the installation path and click **Next**.

5. Ensure that only the **Vantage Dispatcher** component is selected and click **Next**.

6. Specify the IBM Cognos Dispatcher directory and click **Next**.

7. Wait for files to be copied to the specified location and click **Next**

8. Optionally, click **Generate an automatic installation script** in order to save an XML file containing all the parameters you set on the previous pages.

9. Click **Done**.

10. After installing on Linux and UNIX platforms, navigate to `em4c_location/configure` and enter the following:
    ```
    [cognosuser@server1]$ chmod +x setPermissions.sh
    [cognosuser@server1]$ ./setPermissions.sh
    ```

### 4.4.2 Configuring using Esri Maps for IBM Cognos Configuration

Before you complete the following steps, make sure you are familiar with the available configuration settings.

On Windows, run Esri Maps for IBM Cognos Configuration as a user with administrator privileges. On Linux and UNIX, run Esri Maps for IBM Cognos Configuration as the user who owns the Esri Maps for IBM Cognos installation location (this user should have READ/WRITE/EXECUTE access to both the `em4c_location` and the `cognos_location`).

1. Do one of the following:
   - On Windows, navigate to the `em4c_location\configure` directory and launch `configure.bat`. 
On Linux or UNIX, navigate to the `em4c_location/configure` directory and run one of the following:

- `./configure.sh` (Linux)
- `./configure-aix.sh` (AIX)
- `./configure-systemz.sh` (System z)

2. In the Explorer window, click **Local Configuration**.

3. Change the Local Configuration settings to reflect your environment (for example, the host name portion of any URI should be changed from localhost to an IP address or a network host name). The Esri Maps for IBM Cognos Configuration application recognizes which Vantage components are installed and only lists the configuration settings that are required to be set.

4. Click the **Apply** button.

5. From the **File** menu, click **Exit**.

### 4.4.3 Restarting the IBM Cognos Service

Changes applied in Esri Maps for IBM Cognos Configuration require that the IBM Cognos Service be restarted on any IBM Cognos Dispatcher computer that is running the report service and/or presentation service.

Refer to the *IBM Cognos Installation and Configuration Guide* for your version of IBM Cognos for details on how to restart the IBM Cognos service.

At this point, all Esri Maps for IBM Cognos report authors and end users should clear their web browser cache. The instructions for this vary among browsers, but CTRL-SHIFT-DELETE will work in most browsers.

### 4.5 Vantage Gateway

The Vantage Gateway gets installed on each IBM Cognos Gateway computer in your environment. Installing and configuring Vantage Gateway involves the following steps:

**Step 1. Install Vantage Gateway.**

**Step 2. Configure using Esri Maps for IBM Cognos Configuration.**

**Step 3. Configure the web server.**

**Step 4. Perform additional administrative tasks.**

### 4.5.1 Installing Vantage Gateway

A complete installation of Esri Maps for IBM Cognos involves installing components on your server then configuring them to work in your environment. Before you begin, make sure you are familiar with the installation options.

On Windows, the following steps should be performed as an administrator. On Linux and UNIX, it is recommended that the following steps be performed as the user who owns the IBM Cognos installation location.

On Linux and UNIX platforms, install Esri Maps for IBM Cognos components in a directory that contains only ASCII characters in the path.
1. Do one of the following:
   - On Windows, in the Vantage directory on the installation media, launch the correct installer batch file (.bat) for your version of IBM Cognos. For example:
     
     G:\Vantage>launchInstallerC10_2.bat
   - On Linux or UNIX, in terminal, navigate to the Vantage directory on the installation media, and launch the installer that reflects your version/platform of IBM Cognos. For example
     
     [cognosuser@server1]$ ./launchInstallerC10_2.sh

2. On the Welcome page, click Next.
3. If you accept the terms of the license agreement, click Next; otherwise, click Quit to exit.
4. Select the installation path and click Next.
5. Ensure that only the Vantage Gateway component is selected and click Next.
6. Specify the IBM Cognos Gateway Directory and click Next.
7. Wait for files to be copied to the specified location and click Next.
8. Optionally, click Generate an automatic installation script in order to save an XML file containing all the parameters you set on the previous pages.
9. Click Done.
10. After installing on Linux and UNIX platforms, navigate to em4c_location/configure and enter the following:
    
    [cognosuser@server1]$ chmod +x setPermissions.sh
    [cognosuser@server1]$ ./setPermissions.sh

4.5.2 Configuring using Esri Maps for IBM Cognos Configuration

Before you complete the following steps, make sure you are familiar with the available configuration settings.

On Windows, run Esri Maps for IBM Cognos Configuration as a user with administrator privileges. On Linux and UNIX, run Esri Maps for IBM Cognos Configuration as the user who owns the Esri Maps for IBM Cognos installation location (this user should have READ/ WRITE/EXECUTE access to both the em4c_location and the cognos_location).

1. Do one of the following:
   - On Windows, navigate to the em4c_location\configure directory and launch configure.bat.
   - On Linux or UNIX, navigate to the em4c_location/configure directory and run one of the following:
     
     ./configure.sh (Linux)
     ./configure-aix.sh (AIX)
     ./configure-systemz.sh (System z)

2. In the Explorer window, click Local Configuration.
3. Change the Local Configuration settings to reflect your environment (for example, the host name portion of any URI should be changed from localhost to an IP address or a network host name). The Esri Maps for IBM Cognos Configuration application recognizes
which Vantage components are installed and only lists the configuration settings that are required to be set.

4. Click the **Apply** button.
5. From the **File** menu, click **Exit**.

### 4.5.3 Configuring the web server

In order for Esri Maps for IBM Cognos and IBM Cognos to communicate, you must create the virtual directories (aliases) listed in the following table. Note that it is assumed IBM Cognos is exposed on your web server as ibmcognos (modify to reflect your environment).

<table>
<thead>
<tr>
<th>Alias</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>ibmcognos/esriViewer</td>
<td>em4c_location/gateway/webcontent/esriViewer</td>
</tr>
<tr>
<td>ibmcognos/vantage</td>
<td>em4c_location/gateway/webcontent/vantage</td>
</tr>
<tr>
<td>ibmcognos/vantage/cgi-bin</td>
<td>cgi-bin directory that reflects your environment, for example em4c_location/gateway/cgi/linux-64/cgi-bin</td>
</tr>
</tbody>
</table>

**Table 7: Esri Maps for IBM Cognos virtual directories**

Detailed configuration steps for the following web servers are included as an appendix to this document.

- Microsoft Internet Information Services 6 (IIS6)
- Microsoft Internet Information Services 7.x (IIS7)
- Apache

### 4.5.4 Performing additional administrative tasks

Before report authors can start using Esri Maps for IBM Cognos to enhance reports with maps, there are some additional administrative tasks that must be performed. Not all additional tasks will be applicable to your environment.
5 Uninstalling Esri Maps for IBM Cognos

Uninstalling Esri Maps for IBM Cognos requires the removal of all components both inside and outside of IBM Cognos.

The following procedure is for uninstalling when all Esri Maps for IBM Cognos components are installed on one computer. You must repeat the uninstallation process on each computer that contains Esri Maps for IBM Cognos components. Not all steps are applicable to all computers.

Step 1. Disable Esri Maps for IBM Cognos.
Step 2. Stop Vantage Server.
Step 3. Remove web server components.
Step 4. Delete (or rename) installed files.

5.1.1 Disabling Esri Maps for IBM Cognos

This step is to be performed on all Vantage Gateway and Vantage Dispatcher locations in your environment. The purpose of this step is to return IBM Cognos back to its original state. All files modified by the Esri Maps for IBM Cognos configuration process are restored.

To disable Esri Maps for IBM Cognos, you must

1. Return IBM Cognos files back to their original state.
2. Restart affected IBM Cognos Dispatchers.

Returning IBM Cognos files back to their original state

On Windows, perform the following as a user with administrator privileges. On Linux and UNIX, perform the following as the user who owns the Esri Maps for IBM Cognos installation location.

1. Do one of the following:
   - On Windows, navigate to the em4c_location\configure directory and launch configure.bat.
   - On Linux or UNIX, navigate to the em4c_location/configure directory and run one of the following:
     .configure.sh (Linux)
     ./configure-aix.sh (AIX)
     ./configure-systemz.sh (System z)

2. Click the Disable button.
3. From the File menu, click Exit.

Note: Esri Maps for IBM Cognos can be disabled silently. On Windows, the following should be performed as a user with administrator privileges. On Linux and UNIX, the following should be run as the user who owns the Esri Maps for IBM Cognos installation location.

1. Do one of the following:
   - On Windows, in a command prompt (cmd.exe) running as administrator, navigate to the em4c_location\configure directory and enter the following command:
     configure.bat -remove
Uninstalling Esri Maps for IBM Cognos

- On Linux and UNIX, navigate to the `em4c_location/configure` directory and run one of the following:
  - `./configure.sh -remove` (Linux)
  - `./configure-aix.sh -remove` (AIX)
  - `./configure-systemz.sh -remove` (System z)

**Note:** On the Windows platform, the default name of the Windows service is EM4C. If you are running Esri Maps for IBM Cognos using a non-default Vantage Server HTTP Port, the name of the service is EM4C<port>. For example, if the Vantage Server HTTP Port is 1234, the service is named EM4C1234. If you are disabling Esri Maps for IBM Cognos and you note that you have an orphaned EM4C service, you can delete it as follows in a command prompt running as administrator:
  ```
  sc stop EM4C
  sc delete EM4C
  ```

**Restarting the IBM Cognos Service**

The Vantage Dispatcher is installed once for each IBM Cognos Dispatcher running the report and/or presentation service. After Esri Maps for IBM Cognos has been disabled for these environments, the IBM Cognos service needs to be **restarted**.

Once the IBM Cognos Service has been restarted for all affected IBM Cognos Dispatchers, report authors and end users should clear their browser caches.

### 5.1.2 Stopping/removing the Vantage Server

For each Vantage Server location in your environment, the Esri Maps for IBM Cognos Vantage Server needs to be stopped.

**Note:** On the Windows platform, the Vantage Server was stopped when you clicked **Disable** in Esri Maps for IBM Cognos Configuration.

On Linux and UNIX, the following should be run as the user who owns the Esri Maps for IBM Cognos installation location.

1. Navigate to the `em4c_location\server\bin` directory and run one of the following:
   - `./stop-vantage.sh` (Linux)
   - `./stop-vantage-aix.sh` (AIX)
   - `./stop-vantage-systemz.sh` (System z)

### 5.1.3 Removing the web server components

The following is to be completed on each IBM Cognos Gateway computer.

During the installation and configuration process for Esri Maps for IBM Cognos (any version), you were instructed to configure a web server. The components added to your web server can be safely removed at this time. It is recommended that you remove them in the reverse order in which you added them.
5.1.4 Deleting (or renaming) installed files

The following is to be completed everywhere Esri Maps for IBM Cognos components were installed.

The uninstallation steps performed above have not deleted anything. If it is your intention that Esri Maps for IBM Cognos not be reinstalled, you can safely delete `em4c_location` from all of your environments.

If you are planning to upgrade Esri Maps for IBM Cognos from an older version (or are doing a reinstallation to recover a corrupted or incomplete installation), it is recommended that you rename `em4c_location` until after the new installation and configuration process has been completed and tested. The reason for this is that each Esri Maps for IBM Cognos environment has many configuration files that contain information that can be reused between versions.

- `em4c_location\configure\vantage.xml`
- `em4c_location\server\webapps\esriViewer\MapServiceIDs.txt` (ver. 4.3.1 and below)
- `em4c_location\server\webapps\esriViewer\ServiceIDs.txt` (ver. 4.3.2 and above)
- `em4c_location\server\webapps\esriViewer\MapServices.txt`
- `em4c_location\server\webapps\esriViewer\esriConfig\config-default.xml`
- `em4c_location\server\webapps\esriViewer\esriConfig\ConfigurableOptions.xml`
- `em4c_location\server\webapps\esriViewer\esriViewer\ConfigurableViewerStyles.xml`
- `em4c_location\server\webapps\esriViewer\esriViewer\uploadedImages` (the whole directory)
- `em4c_location\server\webapps\esriViewer\license.lic` (this is a legacy file and not all customers have one)

You cannot copy many of these files into a new Esri Maps for IBM Cognos environment due to changes that may have been made in new versions. These files do, however, contain information that is valuable. When configuring your new environment, it is recommended that you open the old version of these files and copy/paste relevant configuration information into the new version.

**Reminder:** There were files added to IBM Cognos by the Esri Maps for IBM Cognos installation process. You can safely delete those files at this time or leave them alone. They will not affect the normal operation of IBM Cognos.
6 Upgrading Esri Maps for IBM Cognos

Upgrading Esri Maps for IBM Cognos from a previous version involves uninstalling the software and reinstalling and configuring it. Refer to the appropriate sections of this document for guidance.
7 Additional administrative tasks

7.1 Upgrading reports from previous versions

When Esri Maps for IBM Cognos is upgraded to a new version, reports created at past versions of Esri Maps for IBM Cognos must be updated. Upgrading map-enabled reports can be done using the following steps:

Step 1. Back up your content store (optional, but highly recommended).
Step 2. Log in to IBM Cognos Connection as an administrator.
Step 3. Use the Esri Maps for IBM Cognos upgrade utility.

1. In the web browser, navigate to http://servername/ibmcognos/vantage/upgrade/index.html (substitute your server name and IBM Cognos alias).
2. In the left pane of the upgrade utility, select the locations you want to search for Esri Maps for IBM Cognos reports and click Search.
3. In the right pane, select the reports that you want to upgrade and click Upgrade.

7.2 Adding map services

Report authors in your environment use map services exposed by ArcGIS for Server to access maps and attribute data. The list of map services available to them is controlled by two files: ServiceIDs.txt and MapServices.txt (located at em4c_location/server/webapps/esriViewer on each Vantage Server computer). When report authors in your organization need maps from other servers, these two files need to be edited.

To do this, you need to first contact an ArcGIS for Server administrator and ask for the endpoint (URL) of their ArcGIS for Server Services Directory (every ArcGIS for Server instance has a Services Directory created during the installation process). The default endpoint for ArcGIS for Server is:

http://<host>/<site>/rest/services

Where

- <host> is the ArcGIS Server host name.
- <site> is the site name. The default value is arcgis.
- rest/services: This indicates the services endpoint Esri Maps for IBM Cognos will use to find map services.

For example, the URL for the root directory of Sample Server 1 on ArcGIS Online services, is

http://sampleserver1.arcgisonline.com/arcgis/rest/services

ServiceIDs.txt and MapServices.txt can have as many entries as needed to reflect all the services report authors in your organization need. Exact copies of these two files need to be placed on every Vantage Server computer in your environment.

An example configuration of these files is as follows:

ServiceIDs.txt:

ESRIRESOURCE_CENTER
server.arcgisonline.com
MapServices.txt:
Esri Map Services
http://[ID:ESRI_RESOURCE_CENTER]/ArcGIS/rest/services

Note the following:

- Domains get entered into ServiceIDs.txt on two lines. The first line is a unique identifier (ID). The second line is a domain or IP address. If necessary, you can append a port to the domain name/IP address with a colon (for example, server.arcgisonline.com:80).
- Map servers get listed in MapServices.txt on two lines. The first line is a label that report authors see when configuring maps in Esri Maps Designer. The second line specifies the URL to a valid ArcGIS for server instance.
- Domains get replaced in MapServices.txt using the ID. The ID must be enclosed in square brackets and must be prefixed as "ID:".
- ServiceIDs.txt and MapServices.txt are case-sensitive.
- The string "ID:" in MapServiceIDs.txt must be uppercase.

To add the contents of Esri’s Sample Server 1 to your environment, you should modify the service files as follows:

ServiceIDs.txt:
ESRIRESOURCE_CENTER
server.arcgisonline.com
ESRISAMPLE_SERVER
sampleserver1.arcgisonline.com

MapServices.txt:
Esri Map Services
http://[ID:ESRIRESOURCE_CENTER]/ArcGIS/rest/services
Esri Sample Services
http://[ID:ESRISAMPLE_SERVER]/ArcGIS/rest/services

To add the contents of your organization’s development environment, you should modify the service files as follows (substitute your organization’s ArcGIS for Server information as appropriate):

ServiceIDs.txt:
ESRIRESOURCE_CENTER
server.arcgisonline.com
TEST_SERVER
ott-app-vmw-d11:6080

MapServices.txt:
Esri Map Services
http://[ID:TEST_SERVER]/ArcGIS/rest/services
Test Services
http://[ID:TEST_SERVER]/ArcGIS/rest/services

The biggest benefit of ServiceIDs.txt and MapServices.txt is that they greatly simplify the moving of map-enabled reports when transitioning from a development environment to a production environment. In many organizations, map-enabled reports authored in a development environment will refer to map services exposed by an ArcGIS for Server environment that is also in the development stage. When such reports are moved from development to production, the referenced map services still point to a development ArcGIS for Server instance. Rather than forcing report authors to update all map-enabled reports to point to the production ArcGIS for Server instance, the process can be made much easier by
making changes to ServiceIDs.txt and MapServices.txt on the production Vantage Server computers.

**Note:** If IBM Cognos is configured to use the Secure Sockets Layer (SSL) protocol to secure communication between the IBM Cognos gateways and user browsers in your environment, Esri Maps for IBM Cognos will automatically try to use SSL to connect to ArcGIS for Server services. You do not need to enter https into MapServices.txt (although it does not hurt to do so). The obvious implication of this, however, is that any ArcGIS for Server whose services you want to make available to report authors in your environment must have SSL enabled.

### 7.3 Cross-domain security considerations

For security reasons, web browsers cannot access maps and data that reside outside the exact domain where an IBM Cognos report originated. This security restriction can be lifted, however, if permission is explicitly granted from the server serving the map. This is accomplished by including a small crossdomain.xml file on the remote server. For example:

```xml
<?xml version="1.0"?>
<!DOCTYPE cross-domain-policy SYSTEM "http://www.adobe.com/xml/dtds/cross-domain-policy.dtd">
<cross-domain-policy>
  <site-control permitted-cross-domain-policies="all"/>
  <allow-access-from domain="*"/>
</cross-domain-policy>
```

Esri Maps for IBM Cognos leverages services exposed by ArcGIS for Server. Cross-domain issues will arise whenever Esri Maps for IBM Cognos attempts to leverage a service from outside the domain where IBM Cognos resides. When cross-domain issues do arise, the remote server’s administrator must set up a crossdomain.xml file. The process for doing this is outlined in the ArcGIS for Server help files for their version/platform.

For more information about crossdomain.xml, refer to the cross domain policy file specification.

### 7.4 Creating a default map

Once Esri Maps for IBM Cognos is installed and configured in your environment, report authors will create reports augmented with maps. If your organization wishes to standardize a template, or default, from which report authors start, you can have one report author go through the process of creating the default map using the Esri Maps Designer, which they access from Cognos Connection. Once the default map has been configured, that map’s XML should be saved as a file named config-default.xml and the new XML file should be copied to `em4c_location/server/webapps/esriViewer/esriConfig` for each Vantage Server in your environment.

### 7.5 Alternate geometry service

Every Esri Maps for IBM Cognos implementation requires access to a geometry service. The geometry service helps Esri Maps for IBM Cognos do geometric calculations such as buffering geometric shapes, calculating areas and lengths, and so on.

By default, Esri Maps for IBM Cognos comes preconfigured to use a geometry service published by Esri. This service is free and you can read about it here: [http://www.esri.com/software/arcgis/arcgis-online-map-and-geoservices/geoservices](http://www.esri.com/software/arcgis/arcgis-online-map-and-geoservices/geoservices)
Note that there are some Access and Use Constraints associated with this free service and you can read a summary here:

Many organizations will use the preconfigured geometry service; however, the geometry service must be changed if

- Internet access is not permitted in local environment
- Security policies exist in local network that prevent users from accessing this service

To change the default location of the geometry service, you must first obtain the URL of a geometry service from an ArcGIS for Server administrator. Then, you must edit config-default.xml, located at em4c_location/server/webapps/esriViewer/esriConfig. Specifically, you must edit the URL item for the service named geometryService. For the URL value, you can reuse one of the server IDs listed in ServiceIDs.txt (see Adding map services), or you can hard code the value directly. The following example shows both options. Choose the one that works best for your organization.

**Option 1:**
```xml
<service name="geometryService" id="geometryService">
  <url>http://[ID:ESRI_TASKS]/ArcGIS/rest/services/Geometry/GeometryServer</url>
</service>
```

**Option 2:**
```xml
<service name="geometryService" id="geometryService">
</service>
```

**Note:** If IBM Cognos is configured to use the Secure Sockets Layer (SSL) protocol to secure communication between the IBM Cognos gateways and browsers in your environment, Esri Maps for IBM Cognos will automatically try to use SSL to connect to ArcGIS for Server services. You do not need to enter https into config-default.xml (although it will not affect anything to do so). The obvious implication of this, however, is that any ArcGIS for Server whose services you want to make available to report authors in your environment must have SSL enabled.

### 7.6 Configurable options

You have the ability to control certain aspects of the Esri Maps Designer application that report authors use to configure map-enabled reports. For example, administrators can add, remove, or change many of the default options report authors are presented with. These options are contained within ConfigurableOptions.xml (located at em4c_location/server/webapps/esriViewer/esriConfig). This XML file internally contains instructions on what and how to change the configurable options.

### 7.7 Configurable Viewer Styles

Through the use of attributes stored in ConfigurableViewerFiles.xml (located at server/webapps/esriViewer on each Vantage Server computer), you can modify the appearance of many user-interface components report consumers will see when using map-enabled reports. These properties can define, for example, the size of a font used in a label control or the background color of a map tip.
The following example is the default implementation for a map tip seen by a report consumer.

```xml
<style name=".infoSymbLabel">
  <attribute name="color" value="#000000" />
  <attribute name="backgroundColor" value="#CCCCCC" />
  <attribute name="alpha" value="0.8" />
  <attribute name="backgroundAlpha" value="1.0" />
  <attribute name="fontWeight" value="normal" />
  <attribute name="fontSize" value="12" />
  <attribute name="fontFamily" value="Verdana" />
  <attribute name="top" value="2" />
  <attribute name="bottom" value="2" />
  <attribute name="right" value="2" />
  <attribute name="left" value="2" />
  <attribute name="paddingTop" value="2" />
  <attribute name="paddingBottom" value="2" />
  <attribute name="paddingRight" value="2" />
  <attribute name="paddingLeft" value="2" />
  <attribute name="alignmentBaseline" value="useDominantBaseline" />
</style>
```

For any style listed in ConfigurableViewerFiles.xml, you can add attribute elements. For example, if the above did not include an attribute for fontFamily, it could be added. If you specify a style attribute that does not make sense for a particular style, it will not be rendered at runtime.

The above XML implementation of styles/attributes is based on Adobe Flex styles. For more information on available style attributes, see the About supported styles section at http://livedocs.adobe.com/flex/3/html/help.html?content=styles_02.html.

### 7.8 Custom images

Esri Maps for IBM Cognos comes with a series of images that can be used to symbolize points on a map. If report authors in your organization require additional images, they can be copied to `em4c_location\server\webapps\esriViewer\uploadedImages` on each Vantage Server computer. The image format can be a JPG, GIF, PNG, SWF, or SVG.

**Tip:** If report authors find that the list of default images provided is too large, you can organize the uploadedImages directory in any way that makes sense to the report authors.

### 7.9 Controlling who can access Esri Maps for IBM Cognos

The Esri Maps for IBM Cognos installation adds an item to the IBM Cognos runtime environment. Specifically, an item named Esri Maps Designer is added to the Launch menu in Cognos Connection.
Additional administrative tasks

Figure 9: Esri Maps Designer Launch menu item

This Esri Maps Designer item appears (by default) only for System Administrators and Report Studio users (Administrators and RSUsers). This list can be changed by modifying system.xml located at cognos_location/templates/ps/portal on each IBM Cognos Dispatcher computer. Modify the show property of the following XML fragment to list Cognos groups or roles:

```
<param name="ui_add">
  <CRN_HEADER_OPTIONS>
    <item show="Administrators RSUsers g1 g2">
      <url><![CDATA[content deleted for readability]]></url>
      <label xml:lang="en">Esri Maps Designer</label>
      <tooltip xml:lang="en"> Esri Maps Designer </tooltip>
    </item>
  </CRN_HEADER_OPTIONS>
</param>
```

The above changes require that the IBM Cognos Service be restarted on the affected IBM Cognos Dispatcher computers.

Refer to the IBM Cognos Installation and Configuration Guide for your version of IBM Cognos for details on how to restart the IBM Cognos service.

7.10 Required IBM Cognos Capabilities

All end users of reports configured with Esri Maps for IBM Cognos require the capability to execute report specifications. Thus, all intended consumers of augmented content need to obtain certain system capabilities. The following are to be completed by an IBM Cognos administrator:

1. In a web browser, navigate to IBM Cognos Administration and click Security > Capabilities.
2. Click the Report Studio > Set Properties capability.
3. Click the Permissions tab and set the following permissions for all users, groups, and roles that are permitted to consume reports augmented by Esri Maps for IBM Cognos:
   - Traverse
4. Click OK to return to the main security capabilities page.
6. Click the Permissions tab and set the following permissions for the same users, groups, and roles in step 3:
   - Traverse
   - Execute
   - Read
7. Click **OK** to return to the main security capabilities page.

8. Click the **Specification > Set Properties** capability.

9. Click the **Permissions** tab and set the following permissions for the same users, groups, and roles in step 3:
   - Execute

   **Note:** Starting at IBM Cognos 8.4.1, the capabilities above can be overwritten at the package level. If it is your intention to set capabilities in this way, ensure that users have the same capabilities as stated above for each affected package.

### 7.11 Changing the logging levels

Changing the logging level can help troubleshoot installation and configuration issues. The following log levels are available for **Vantage Server** and **Vantage Dispatcher**:

- **DEBUG**
- **INFO**
- **WARN**
- **ERROR**
- **FATAL**

#### 7.11.1 Vantage Server

The default level of logging is **ERROR**, which is suitable in most situations.

To change the log settings for the Vantage Server, the following must be completed on each Vantage Server computer. These steps are to be performed by an administrator on Windows or the user who owns `em4c_location` on Linux/UNIX.

1. Navigate to `em4c_location\server\webapps\vantage\WEB-INF\classes`.
2. Open `log4j.properties` file in a text editor.
3. Change the following lines (as appropriate):

   ```
   log4j.logger.com.spotonsystems.cognos.custom.customRequestHandler=ERROR, stdout
   log4j.logger.com.spotonsystems.vip=INFO, stdout, A1
   ```

4. Restart the Vantage Server (Windows service or Linux/UNIX process).

   **Note:** You can use Esri Maps for IBM Configuration on the Vantage Server computer to change log file location for this component.

#### 7.11.2 Vantage Dispatcher

Vantage Dispatcher logging needs to be manually configured.

By default, the Vantage Dispatcher logs its entries in the IBM Cognos cogserver.log file. Enabling additional logging for Vantage Dispatcher should only be performed when troubleshooting with **Esri Support**.
7.12 IBM Cognos Fix Packs

After installing an IBM Cognos Fix Pack, you must open Esri Maps for IBM Cognos Configuration on all Vantage Gateway and Vantage Dispatcher computers and click Apply. The IBM Cognos Service must then be restarted on any IBM Cognos Dispatcher computer that is running the report service and/or presentation service.
8 Appendices

8.1 Configuring the web server

In order for Esri Maps for IBM Cognos and IBM Cognos to communicate, you must create virtual directories, or aliases.

**Important:** If IBM Cognos is exposed on multiple paths in your environment, Esri Maps for IBM Cognos has to be configured to reflect this. For example, if IBM Cognos is available at both http://cognosserver/ibmcognos and http://ibmcognos, the following steps must be modified so that the following will be true:

- http://cognosserver/ibmcognos/esriViewer
- http://cognosserver/ibmcognos/vantage
- http://cognosserver/ibmcognos/vantage/cgi-bin
- http://ibmcognos/esriViewer
- http://ibmcognos/vantage
- http://ibmcognos/vantage/cgi-bin

8.1.1 *Microsoft Internet Information Services 6 (IIS 6)*

This topic assumes IBM Cognos Business Intelligence has already been set up to work with Internet Information Services 6 (IIS6), that IBM Cognos runs in the Default Web Site and that the IBM Cognos virtual directory is named ibmcognos.

The following steps are to be completed on each Esri Maps for IBM Cognos Vantage Gateway computer in your environment and should be performed by a user who is part for the Administrators group on the IIS 6 computer.

*Configuring an application pool*

The Esri Maps for IBM Cognos Vantage Gateway modules need to be executed in the context of an IIS 6 application pool. While it's most convenient to use the Default Application Pool, it's recommended that you define an additional application pool. The following will create an application pool named VantageAppPool.

Open Internet Information Services Manager by clicking **Start > Administrative Tools > Internet Information Services (IIS) Manager**.

1. Expand the <server name>.
2. Right-click **Application Pools** and click **New > Application Pool**.
3. Provide the required details in the **Add New Application Pool** dialog box.
   - The application pool ID is **VantageAppPool**.
4. Use default settings for the new application pool.
5. Click **OK**.

The above steps create an application pool that runs under the default Network Service account. If this account does not have the proper permissions, the Vantage CGI script Esri Maps for IBM Cognos uses will not be able to operate properly. The required permissions are "Adjust memory quotas for a process (SeIncreaseQuota)" and "Replace a process at token
level \( \text{SeAssignPrimaryToken} \)". The following knowledge base article from Microsoft provides several solutions: \url{http://support.microsoft.com/kb/904056}.

**Creating the virtual directories**

IIS serves its content to clients by exposing a virtual directory tree. Both Esri Maps for IBM Cognos content and IBM Cognos content must be served as subdirectories of the IBM Cognos virtual directory.

Esri Maps for IBM Cognos content must be served from the same domain (and port) as IBM Cognos content. The following outlines the steps to create two virtual directories: esriViewer and vantage. These names cannot be changed in order for Esri Maps for IBM Cognos to function properly. This topic assumes that IBM Cognos runs in the Default Web Site and that the IBM Cognos virtual directory is named ibmcognos (for example, \url{http://cognosserver/ibmcognos}).

1. In IIS Manager’s left explorer pane, expand **Web Sites** and expand **Default Web Site**.
2. Right-click the ibmcognos virtual directory and click **New > Virtual Directory**.
3. Click **Next** to move to the second page of the Virtual Directory Creation Wizard.
4. Enter esriViewer as the **Alias** and click **Next**
5. Click the **Browse** button and navigate to \( \text{em4c\_location}\backslash\text{gateway}\backslash\text{webcontent}\backslash\text{esriViewer} \) and click **OK**.
6. Click **Next**.
7. Ensure the **Read** check box is checked and click **Next**.
8. Click **Finish**.
9. Right-click the ibmcognos virtual directory and click **New > Virtual Directory**.
10. Click **Next** to move to the second page of the Virtual Directory Creation Wizard.
11. Enter vantage as the **Alias** and click **Next**.
12. Click the **Browse** button and navigate to \( \text{em4c\_location}\backslash\text{gateway}\backslash\text{webcontent}\backslash\text{vantage} \) and click **OK**.
13. Click **Next**.
14. Ensure the **Read** check box is selected and click **Next**.
15. Click **Finish**.

**Creating an application for cgi-bin**

Creating an IIS application for cgi-bin will map the Vantage Gateway modules to the application pool in which the IBM Cognos website runs (for example, Default Web Site).

1. In the IIS Manager’s left explorer pane, expand **Web Sites** and expand **Default Web Site**.
2. Right-click the vantage virtual directory and click **New > Virtual Directory**.
3. Click **Next** to move to the second page of the Virtual Directory Creation Wizard.
4. Enter \( \text{cgi-bin} \) as the **Alias** and click **Next**.
5. Click the Browse button, select one of the following, and click **OK**:
   - `em4c_location\gateway\cgi\win-64\cgi-bin`
   - `em4c_location\gateway\cgi\win-32\cgi-bin`

6. Click **Next**.

7. Ensure both the **Read** and **Execute** check boxes are selected and click **Next**.

8. Click **Finish**.

### Setting the application pool for the cgi-bin application

1. In IIS Manager's left explorer pane, expand **Web Sites > Default Web Site > ibmcognos > vantage**.
2. Right-click on the cgi-bin virtual directory and click **Properties**.
3. In the **Virtual Directory** tab, under **Application settings**, select **VantageAppPool** from the **Application pool** list.
4. Click **OK**.

### Adding a web service extension

Before you can use an HTTP request handler that is not in the list of web service extensions, you must first register it by adding the HTTP request handler to the list of web service extensions. The steps below register a web service extension for vantage.cgi, which is located in the cgi-bin directory configured above.

1. In IIS Manager's left explorer pane, right-click **Web Service Extensions**, and select **Add a new Web service extension**.
2. Enter `vantage.cgi` as the extension name.
3. Click the **Add** button.
4. Click the **Browse** button, and on the **Open** dialog box that appears, select **All files (.*.*)** from the **Files of type** list.
5. Select the vantage.cgi file from one of the locations listed below and click **Open**:
   - `em4c_location\gateway\cgi\win-64\cgi-bin`
   - `em4c_location\gateway\cgi\win-32\cgi-bin`
6. Click **OK** to close the **Add file** dialog box.
7. Ensure the **Set extension status to Allowed** check box is selected and click **OK**.
   - **Note**: In Internet Information Services (IIS) Manager’s right panel, the vantage.cgi Web Service Extension has a green check icon and its **Status** is set to **Allowed**.

### File access permissions

The Vantage technology pieces need access to read and modify the contents of the Vantage cgi-bin directory. To do this, you must give specific access permissions to the identity that the VantageAppPool runs as. When VantageAppPool was configured above, the default settings were accepted. This means the application pool will be running as the built-in Network Service. If your application pool is not running as this account (for example, it uses a local or domain account), modify the following steps as necessary.

The referenced Esri Maps for IBM Cognos cgi-bin directory will point to one of the following:
- em4c_location\gateway\cgi\win-64\cgi-bin
- em4c_location\gateway\cgi\win-32\cgi-bin

1. In Windows Explorer, right-click the Esri Maps for IBM Cognos cgi-bin directory and select Properties.
2. On the cgi-bin Properties dialog box, click the Security tab.
4. On the Select Users or Groups dialog box, click Locations.
5. On the Locations dialog box, select the <local server you are working on> and click OK.
6. In the Enter the object names to select text area, type Network Service and click Check Names.
7. Click OK to close the Select Users or Groups dialog box.
8. On the cgi-bin Properties dialog box, select NETWORK SERVICE in the Group or user names area and check Allow beside Modify in the Permissions for NETWORK SERVICE area.
9. Click OK to close the cgi-bin Properties dialog box.

### 8.1.2 Microsoft Internet Information Services 7.x

This topic assumes IBM Cognos Business Intelligence has already been set up to work with Microsoft Internet Information Services 7.x (IIS7.x), that IBM Cognos runs in the Default Web Site, and that the IBM Cognos virtual directory is named ibmcognos.

The following steps should be completed on each Esri Maps for IBM Cognos Vantage Gateway computer in your environment and performed by a user who is part for the Administrators group on the IIS 7 computer.

#### Configuring an application pool

The Esri Maps for IBM Cognos Vantage Gateway modules need to be executed in the context of an IIS 7.x application pool. While it’s most convenient to use the Default Application Pool, it’s recommended that you define an additional application pool.

The following will create an application pool named VantageAppPool.

1. Open the Internet Information Services Manager.
   a. Click Start > All Programs > Accessories > Run.
   b. In the Open box, type inetmgr and click OK.
2. Expand <server name>.
3. Right-click Application Pools and select Add Application Pool.
4. Provide the required details in the Add Application Pool dialog box.
   - **Name**: VantageAppPool
   - **.NET Framework version**: .NET Framework v2.0.50727
   - **Managed pipeline model**: Integrated
   - **Start application pool immediately**: Checked
5. Click OK.
Creating the virtual directories

Microsoft IIS serves its content to clients by exposing a virtual directory tree. Both Esri Maps for IBM Cognos content and IBM Cognos content must be served as subdirectories of the IBM Cognos virtual directory.

Esri Maps for IBM Cognos content must be served from the same domain (and port) as IBM Cognos content. The following outlines the steps to create two virtual directories: esriViewer and vantage. These directory names cannot be changed in order for Esri Maps for IBM Cognos to function properly. This topic assumes that IBM Cognos runs in the Default Web Site and that the IBM Cognos virtual directory is named ibmcognos (for example, http://cognosserver/ibmcognos).

1. Open the Internet Information Services Manager.
   a. Click Start > All Programs > Accessories > Run.
   b. In the Open box, type inetmgr and click OK.
2. In the IIS Manager's left explorer pane, expand Sites and expand Default Web Site.
3. Right-click the ibmcognos virtual directory and select Add Virtual Directory.
4. Provide the required details for the Add Virtual Directory dialog box.
   - **Alias:** esriViewer
   - **Physical path:** `em4c_location\gateway\webcontent\esriViewer`
5. Click OK. Right-click the ibmcognos virtual directory and select Add Virtual Directory.
6. Provide the required details for the Add Virtual Directory dialog box.
   - **Alias:** vantage
   - **Physical path:** `em4c_location\gateway\webcontent\vantage`
7. Click OK.

Creating an application for cgi-bin

Creating an IIS application for cgi-bin will map the Vantage Gateway modules to the application pool in which the IBM Cognos web site runs (for example, Default Web Site).

1. In the IIS Manager's left explorer pane, find the vantage virtual directory previously created.
2. Right-click on the vantage virtual directory and select Add Application.
3. Provide the required details in the Add Application dialog box.
   - **Alias:** cgi-bin
   - **Application pool:** VantageAppPool
   - **Physical path:**
     - `em4c_location\gateway\cgi\win-64\cgi-bin`
     - or
     - `em4c_location\gateway\cgi\win-32\cgi-bin`
4. Click OK to save the changes.
Configuring IIS for Vantage CGI gateway

For the Vantage CGI gateway to work, you need to do the following:

- Add the new module as an allowed extension so IIS is not blocking its execution (that is, set the CGI restrictions).
- Add a module mapping to handle requests for the Vantage CGI module.
- Configure properties for CGI programs

Setting the CGI restrictions

The Common Gateway Interface (CGI) role is not included in the default installation of IIS 7.x. To complete the following steps, you must first install the CGI role service. On Windows Server 2008, you do this by going to Server Manager > Roles > Add Role Services.

1. In the IIS Manager’s Connections pane on the left, select <web server name>.
2. In the content pane, select the Features View tab at the bottom.
3. Double-click ISAPI and CGI Restrictions (this will bring up the list of defined restrictions in the middle pane of IIS Manager).
4. In the upper-right Actions pane, click Add.
5. Provide the required details in the Add ISAPI or CGI Restriction dialog box.
   - **ISAPI or CGI Path:**
     - `em4c_location\gateway\cgi\win-64\cgi-bin\vantage.cgi`
     - or
     - `em4c_location\gateway\cgi\win-32\cgi-bin\vantage.cgi`
     
     **Note:** If browsing for vantage.cgi, change the file type to All files (*.*), since .cgi is not a default suffix.
   - **Description:** VANTAGE-CGI (for example)
   - **Allow extension path to execute:** checked
6. Click OK.

Adding module mapping for CGI

1. In the left Connections pane of IIS Manager, select Default Web Site > ibmcognos > vantage > cgi-bin.
2. Select the Features View from the lower bar in the middle pane.
3. Double-click Handler Mappings in the middle pane.
4. In the upper-right Actions pane, click Add Module Mapping.
5. Provide the required details for the Add Module Mapping dialog box:
   - **Request path:** *.cgi
   - **Module:** CgiModule (fastCGIModule is not supported)
   - **Executable (optional):** <leave blank>
   - **Name:** VANTAGE-CGI
6. Click OK.
7. On the Handler Mapping page, VANTAGE-CGI will appear as **Enabled**.

8. With the newly created VANTAGE-CGI mapping selected, click **Edit Feature Permissions** from the upper-right **Actions** pane.

9. In the **Edit Feature Permissions** dialog box, check the **Execute** check box to enable CGI execution.

10. Click **OK**.

**Setting properties for CGI programs**

1. In the left **Connections** pane of IIS Manager, select **Default Web Site** > **ibmcognos** > **vantage** > **cgi-bin**.

2. Select the **Features View** from the lower bar in the middle pane.

3. Double-click **CGI** in the middle pane.

4. Set **Impersonate User** [createProcessAsUser] to False.

5. In the upper-right **Actions** pane, click **Apply**.

6. In the IIS Manager's **Connections** pane, select the web site in which IBM Cognos and Esri Maps for IBM Cognos run (for example, Default Web Site).

7. In the **Actions** pane on the right, click **Restart** under the **Manage Web Site** category.

8. Close IIS Manager.

**File access permissions**

The Vantage technology pieces need access to read and modify the contents of the Vantage cgi-bin directory. To do this, you must give specific access permissions to the identity that the VantageAppPool runs as. When the VantageAppPool was configured above, the default settings were accepted. This means the application pool will be running as IIS AppPool\VantageAppPool. If your application pool is not running as this account (for example, it uses a built-in account such as Network Service, Local System, or Local Service, or as a specific local or domain user identity), modify the following steps as necessary.

In the following, the referenced Esri Maps for IBM Cognos cgi-bin directory will point to one of the following:

- `em4c_location\gateway\cgi\win-64\cgi-bin`
- `em4c_location\gateway\cgi\win-32\cgi-bin`

1. In Windows Explorer, right-click the Esri Maps for IBM Cognos cgi-bin directory and click **Properties**.

2. On the **cgi-bin Properties** dialog box, click the **Security** tab.

3. On the **Security** tab, click **Edit**.

4. On the **Permissions for cgi-bin** dialog box, click **Add**.

5. On the **Select Users, Computers, Service Accounts, or Groups** dialog box, click **Locations**.

6. On the **Locations** dialog box, select the `<local server you are working on>` and click **OK**.

7. In the **Enter the object names to select text** area, type `IIS AppPool\VantageAppPool` and click **Check Names**.

8. Click **OK** to close the **Select Users or Groups** dialog box.
9. On the Permissions for cgi-bin dialog box, select VantageAppPool in the Group or user names area and check Allow beside Modify in the Permissions for VantageAppPool area.

10. Click OK to close the Permissions for cgi-bin dialog box.

11. Click OK to close the cgi-bin Properties dialog box.

Note: For some early releases of Windows 2008, the above procedure may not work as described. If this is the case in your environment, you can still manipulate the access control list for the application pool’s identity. The following command can be run from the command prompt (cmd.exe) as an administrator. Modify the location of the cgi-bin and the name of the application pool to suit your environment.

```
icacls "C:\Program Files (x86)\EsriMaps\em4c\gateway\cgi\win-64\cgi-bin" /grant "IIS AppPool\VantageAppPool":F/t
```

8.1.3 Apache

This topic assumes IBM Cognos Business Intelligence has already been set up to work with the Apache HTTP Server (or an Apache-based web server) and that the IBM Cognos alias is named ibmcognos.

Apache is configured by placing directives in plain text configuration files. The main configuration file is usually named httpd.conf and is located in the apache_location/conf directory.

In Apache, the Alias directive allows documents to be stored in the local file system other than under the DocumentRoot. The URL path is case-sensitive (including case-insensitive file systems). Specify additional <Directory> sections to cover the destination of aliases. When you are creating an Alias to a directory outside of the DocumentRoot, you should permit access to the target directory.

The ScriptAlias directive tells Apache that a particular directory is set aside for CGI programs. Apache will assume that every file in this directory is a CGI program and attempt to execute it when that particular resource is requested by a client.

If IBM Cognos is already working in your environment, the following will be assumed. It is worth noting, however, that if your version of Apache has been built with shared module support, ensure that the required modules are loaded. In your httpd.conf file, ensure the LoadModule directive has not been commented out for the following modules:

- `LoadModule dir_module modules/mod_dir.so`
- `LoadModule alias_module modules/mod_alias.so`
- `LoadModule cgi_module modules/mod_cgi.so`

If your organization uses the mod_deflate module (or any other compression module) to reduce the size of content before it is sent over the network, it is important to note that the Vantage cgi_bin directory should not have its content compressed. Your environment should be configured accordingly.

The following steps should be completed on each Esri Maps for IBM Cognos Vantage Gateway computer in your environment.

**Windows**

To successfully run Esri Maps for IBM Cognos, Apache’s main configuration file (httpd.conf) must be modified to add the appropriate Esri Maps for IBM Cognos aliases and script aliases.
Before you begin, take note of the Vantage cgi-bin directory (as it pertains to your environment). It will be one of the following:

- `em4c_location\gateway\cgi\win-64`
- `em4c_location\gateway\cgi\win-32`

The following creates one script alias named `cgi-bin` and two aliases named `esriViewer` and `vantage`. In order for Esri Maps for IBM Cognos to function properly, these names cannot be changed. The following assumes that Esri Maps for IBM Cognos has been installed in `C:\Program Files (x86)\esrimaps\em4c` and that the changes to the Apache configuration file are made by a user who has write access to the Apache installation location (for example, an administrator). It is important that the vantage/cgi-bin script alias be defined before the vantage alias, and that Esri Maps for IBM Cognos aliases be defined before IBM Cognos aliases. Also note the use of the Linux/UNIX-style forward slash (/) directory separator rather than the Windows backslash (\) directory separator.

After adding the following aliases, restart the web server process.

```plaintext
ScriptAlias /ibmcognos/vantage/cgi-bin "C:/Program Files (x86)/esrimaps/em4c/gateway/cgi/win-64/cgi-bin"
<Directory "C:/Program Files (x86)/esrimaps/em4c/gateway/cgi/win-64/cgi-bin">
    AllowOverride None
    Options None
    Order allow,deny
    Allow from all
</Directory>

Alias /ibmcognos/vantage "C:/Program Files (x86)/esrimaps/em4c/gateway/webcontent/vantage"
<Directory "C:/Program Files (x86)/esrimaps/em4c/gateway/webcontent/vantage">
    AllowOverride None
    Options None
    Order allow,deny
    Allow from all
</Directory>

Alias /ibmcognos/esriViewer "C:/Program Files (x86)/esrimaps/em4c/gateway/webcontent/esriViewer"
<Directory "C:/Program Files (x86)/esrimaps/em4c/gateway/webcontent/esriViewer">
    AllowOverride None
    Options None
    Order allow,deny
    Allow from all
</Directory>

File Access Permissions

In a vast majority of environments, Apache will be installed as a Windows service. The Apache documentation recommends that a separate account (with reduced permissions) be created for running the Apache service. This account (local or domain) requires specific access permissions to the Vantage cgi-bin directory so that the Vantage technology pieces can access/modify its contents as necessary.

Windows 2008

1. In Windows Explorer, right-click the Esri Maps for IBM Cognos cgi-bin directory and select Properties.
2. On the cgi-bin Properties dialog box, click the Security tab.
4. On the Permissions for cgi-bin dialog box, click Add.
5. On the **Select Users, Computers, Service Accounts, or Groups** dialog box, click **Locations**.

6. On the **Locations** dialog box, select the correct location for <Apache service account> and click **OK**.

7. In the **Enter the object names to select text** area, type <Apache service account> and click **Check Names** to verify the account can be found.

8. Click **OK** to close the **Select Users or Groups** dialog box.

9. On the **Permissions for cgi-bin** dialog box, select <Apache service account> in the **Group or user names** area and check **Allow** beside **Modify** in the **Permissions** for <Apache service account>.

10. Click **OK** to close the **Permissions for cgi-bin** dialog box.

11. Click **OK** to close the **cgi-bin Properties** dialog box.

**Windows 2003**

1. In Windows Explorer, right-click the Esri Maps for IBM Cognos cgi-bin directory and select **Properties**.

2. On the **cgi-bin Properties** dialog box, select the **Security** tab.

3. On the **Security** tab, click **Add**.

4. On the **Select Users or Groups** dialog box, click **Locations**.

5. On the **Locations** dialog box, select the correct location for <Apache service account> and click **OK**.

6. In the **Enter the object names to select text** area, type <Apache service account> and click **Check Names** to verify the account can be found.

7. Click **OK** to close the **Select Users or Groups** dialog box.

8. On the **cgi-bin Properties** dialog box, select <Apache service account> in the **Group or user names** area and verify that **Allow** is checked for **Full Control**.

9. Click **OK** to close the **cgi-bin Properties** dialog box.

**Linux and UNIX**

In order for the Vantage Gateway to function properly, verify that the prerequisites have been met.

To run Esri Maps for IBM Cognos, Apache’s main configuration file (httpd.conf) must be modified to add the appropriate Esri Maps for IBM Cognos aliases and script aliases. Before you begin, take note of the Vantage cgi-bin directory (as it pertains to your environment). It will be one of the following:

- `em4c_location/gateway/cgi/linux-32/cgi-bin`
- `em4c_location/gateway/cgi/linux-64/cgi-bin`
- `em4c_location/gateway/cgi/aix-32/cgi-bin`
- `em4c_location/gateway/cgi/aix-64/cgi-bin`
- `em4c_location/gateway/cgi/linux-systemz-64/cgi-bin`

The following creates one script alias named cgi-bin and two aliases named esriView and vantage. These names cannot be changed in order for Esri Maps for IBM Cognos to function
properly. The following assumes that Esri Maps for IBM Cognos has been installed to /opt/esrimaps/em4c and that the changes to the Apache configuration file are made by a user who has write access to the Apache installation location. It is important that the vantage/cgi-bin script alias be defined before the vantage alias, and that Esri Maps for IBM Cognos aliases be defined before IBM Cognos aliases.

After adding the following aliases, restart the web server process.

```
ScriptAlias /ibmcognos/vantage/cgi-bin ”/opt/esrimaps/em4c/gateway/cgi/linux-64/cgi-bin"
<Directory ”/opt/esrimaps/em4c/gateway/cgi/linux-64/cgi-bin”>
   AllowOverride None
   Options None
   Order allow,deny
   Allow from all
</Directory>

Alias /ibmcognos/vantage ”/opt/esrimaps/em4c/gateway/webcontent/vantage"
<Directory ”/opt/esrimaps/em4c/gateway/webcontent/vantage”>
   AllowOverride None
   Options None
   Order allow,deny
   Allow from all
</Directory>

Alias /ibmcognos/esriViewer ”/opt/esrimaps/em4c/gateway/webcontent/esriViewer"
<Directory ”/opt/esrimaps/em4c/gateway/webcontent/esriViewer”>
   AllowOverride None
   Options None
   Order allow,deny
   Allow from all
</Directory>
```

**File access permissions**

On UNIX and Linux operating systems, the account under which Apache runs must have READ/WRITE/EXECUTE access to the cgi-bin directory. There are two approaches to meeting this requirement:

- If Apache web server runs under a specific group, change the Vantage cgi-bin directory’s permissions to ensure that it belongs to the same group as the Apache web server. You can then set READ/WRITE/EXECUTE permissions for the group and remove permissions for others.

- You can change ownership of the Vantage cgi-bin directory and assign READ/WRITE/EXECUTE permissions to the directory’s owner.

## 8.2 Testing the configuration

After Esri Maps for IBM Cognos has been installed and configured, clear your web browser’s cache (CTRL-SHIFT-DELETE on most browsers). You can then test various aspects of the installation and configuration process.

In the following examples, it is assumed IBM Cognos is exposed by an ibmcognos alias.

### 8.2.1 Vantage Server

For each Vantage Server configured in your environment, test whether Vantage Server is listening on the indicated port as follows. Note that the default port 9796 is assumed (change as required):


If this test fails, make sure Vantage Server is started in all places where it is installed.
8.2.2 **Vantage Gateway**

The following tests help indicate whether the Vantage Gateway is working as expected:

- Test that the vantage web server virtual directory (alias) is set up correctly (this also verifies Apply was done in Esri Maps for IBM Cognos Configuration):
  
  http://<cognos_gateway>/ibmcognos/vantage/gateway_test.html

- Test that the esriViewer web server virtual directory (alias) is set up correctly (this also verifies Apply was done in Esri Maps for IBM Cognos Configuration):
  
  http://<cognos_gateway>/ibmcognos/esriViewer/version.txt

- Test whether the Vantage Gateway CGI script is working correctly (connecting to the Vantage Server):
  
  http://<cognos_gateway>/ibmcognos/vantage/cgi-bin/vantage.cgi

When these tests fail to produce the expected results, there are two main reasons. First, Esri Maps for IBM Cognos Configuration was not used (changes to the configuration were not saved/applied). Second, the web server is not configured properly.

8.2.3 **Vantage Dispatcher**

This component actually runs within the IBM Cognos process space and there is limited testing that can be performed manually.

One good indication that the Vantage Dispatcher is installed and configured properly is to start Cognos Connection and verify that Esri Maps Designer appears in the Launch menu.

**Figure 10: Esri Maps Designer in Launch menu**

8.3 **Reports configured with Esri Maps for IBM Cognos**

An IBM Cognos report that has been configured with Esri Maps for IBM Cognos will have its specification updated with Vantage-specific items. These items are required by both IBM Cognos and Esri Maps for IBM Cognos to ensure proper report operation. The following items are added to a Vantage-enabled report:

- Report Variable
- HTML Item
- Conditional Block (contained within a Block)
- Vantage Payload Block

8.3.1 **Report Variable and Conditional Block**

Once a report has been configured by Esri Maps for IBM Cognos, a report string variable named vip_mode is created with the following values:
- **DYNAMIC**
- **STATIC**
- **Other**

The DYNAMIC condition is used to render the map during interactive HTML viewing.

The STATIC condition is used to render the map during PDF and Excel viewing. This condition typically references an image whose source is an export of the map. This report variable is bound to the Conditional Block that has been inserted to hold the map.

When viewing the report in Report Studio, the Other condition is true, showing the original Esri Map container/placeholder.

![Figure 11: Vip_mode report string variable](image)

The newly created Block works to replace the original Esri map placeholder. All attributes set on the original placeholder (which is an image) are copied to this Block; for example, if a border is set on the map placeholder, this setting will be copied to the new Block.

### 8.3.2 HTML Item

Once a report has been configured by Esri Maps for IBM Cognos using the Esri Maps Designer user interface, HTML Items are created.

There will always be at least one HTML Item with a description of Vantage Definition Scripts. This HTML Item contains JavaScript references to the Vantage Gateway files and is required to perform all interaction and synchronization tasks.

![Figure 12: Vantage Definition Scripts HTML item](image)

For each IBM Cognos report element chosen for synchronization during the Esri Maps Designer configuration process (List, Crosstab, Chart, and so on), two HTML Items are added: one at the start and one at the end of the target element. These elements identify the target...
element at runtime so they are capable of receiving and broadcasting information. The descriptions for these HTML Items are the following:

Vantage [object name] Start and Vantage [object name] End. [object name] is the value of the Name property. For example, a Pie Chart has a Name Pie Chart1. The Vantage HTML Items appear as Vantage Pie Chart1 Start and Vantage Pie Chart1 End.

![HTML items surround target elements](image)

**Figure 13: HTML items surround target elements**

**Note:** Report authors should be instructed to not change the **Name** property of any Vantage HTML Items. Doing so will prevent Esri Maps for IBM Cognos from functioning properly.

### 8.3.3 Vantage Payload Block

Once a report has been configured with Esri Maps for IBM Cognos, all the Vantage-related report specifications are stored inside a Vantage Payload Block. This mechanism associates a particular Cognos report with its Vantage-related report specifications. This payload block is set to DONTRENDE and does not get sent to the clients.

![Vantage Payload Block](image)

**Figure 14: Vantage Payload Block**